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Preface 

This document provides instructions for installing and using the Storage Navigator 
Modular program with the graphical user interface.  

This document assumes the following: 

 The user is familiar with the operating system and web browser software on the 
system hosting the Storage Navigator Modular software. 

 The user has a background in data processing and understands storage subsystems 
and their basic functions. 

 The user is familiar with the AMS/WMS subsystem and has read and understands the 
manuals for the subsystem.  

Notes: 

 In this document the term “Storage Navigator” refers to the Storage Navigator 
Modular GUI, unless otherwise noted.  

 In this document instructions with a “CAUTION” label indicate that failure to follow 
the instructions could result in damage to the subsystem or potential loss of data. 

 The Storage Navigator screens shown in this document were captured on a Windows® 
system with the Internet Explorer web browser. The Storage Navigator screens may 
display differently on other operating systems and browsers. 

 For further information, please contact your Hitachi Data Systems account team, or 
visit the Hitachi Data Systems worldwide web site at http://www.hds.com. 

Notice: The use of the Storage Navigator Modular program and all other Hitachi Data 
Systems products is governed by the terms of your agreement(s) with Hitachi Data 
Systems. 

Software Version 

This document revision applies to Hitachi TagmaStore® Adaptable Modular Storage and 
Workgroup Modular Storage Products version 7.10 and higher. 
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Comparing the Web, GUI, and CLI Versions of Storage Navigator Modular 

Storage Navigator Modular software has three separate versions for managing Hitachi 
TagmaStore Adaptable Modular Storage and Workgroup Modular Storage: the Web version 
(described in this user guide), a graphical user interface (GUI) version, and a command 
line interface (CLI) version. Here is an overview: 

 

Application User 
Interface 

Configuration Comparisons User Guide 

Storage Navigator 
Modular for Web 

Web 
browser 

 Operating system: 
Windows® 

 Network: One or more 
storage subsystems, a 
Web server and Web 
client computer are 
connected through a 
LAN. 

 Installation: The 
application is installed on 
the Web server. The 
Java™ runtime 
environment (for running 
Java applets in a 
browser) is installed on 
the Web client computer.  

 Operation: User runs the 
program from a Web 
browser on the client 
computer. 

 Used with 
HiCommand 
Device Manager 
software to help 
centrally manage 
storage 
subsystems.  

 May also be used 
without 
HiCommand 
software. 

 Requires a Web 
server. 

Storage Navigator 
Modular for Web 
User’s Guide 
(MK-95DF719) 

Storage Navigator 
Modular Graphical 
User Interface (GUI) 

Traditional 
graphical 
user 
interface 
(GUI) 

GUI appearance is 
similar to Web version. 

Storage Navigator 
Modular Graphical 
User Interface (GUI) 
User’s Guide 
(MK-95DF711) 

Storage Navigator 
Modular Command 
Line Interface (CLI) 

Command 
line interface 
(CLI) 

 Operating system: 
Windows, or 
UNIX®/Linux® 

 Network: Storage 
subsystems connect to 
the host computer 
through a LAN.  

 Installation and 
operation: Program is 
installed on and run from 
the host computer.  

For users who prefer 
the command line 
interface or want to run 
scripts. 

Storage Navigator 
Modular Command 
Line Interface (CLI) 
User’s Guide 
(MK-95DF712) 
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Convention for Storage Capacity Values 

Storage capacity values for hard disk drives (HDDs) are calculated based on the following 
values: 

1 KB (kilobyte) = 1,000 bytes 
1 MB (megabyte) = 1,0002 bytes 
1 GB (gigabyte) = 1,0003 bytes 
1 TB (terabyte) = 1,0004 bytes 

Storage capacity values for logical units (LUs) are calculated based on the following 
values: 

1 KB (kilobyte) = 1,024 bytes 
1 MB (megabyte) = 1,0242 bytes 
1 GB (gigabyte) = 1,0243 bytes 
1 TB (terabyte) = 1,0244 bytes 

Referenced Documents  

 Hitachi TagmaStore AMS and WMS LUN Management User’s Guide, MK-95DF703 

 Hitachi TagmaStore AMS and WMS SNMP Agent User’s Guide, MK-95DF705 

 Hitachi TagmaStore AMS and WMS Password Protection User’s Guide, MK-95DF704 

 Hitachi TagmaStore AMS and WMS Error Codes, MK-95DF788 

Comments 

Please send us your comments on this document. Make sure to include the document 
title, number, and revision. Please refer to specific section(s) and paragraph(s) whenever 
possible. 

 E-mail: doc.comments@hds.com 

 Fax: 858-695-1186 

 Mail: 
Technical Writing, M/S 35-10 
Hitachi Data Systems 
10277 Scripps Ranch Blvd. 
San Diego, CA 92131 

Thank you! (All comments become the property of Hitachi Data Systems Corporation.) 
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Chapter 1 Overview of TagmaStore® AMS and WMS 

1.1 Overview of TagmaStore AMS and WMS 

The TagmaStore Adaptable Modular Storage (AMS) and Workgroup Modular Storage (WMS) 
provide scalable, cost-effective modular storage for Microsoft Exchange Server and other 
business applications. You can use the AMS or WMS to implement storage consolidation, 
first SAN deployment, backup, or data archiving. 

The AMS and WMS enable you to meet compliance requirements, protect your data, and 
reduce recovery times, while benefiting from flexible storage solutions that allow you to 
manage your data growth. The centralized storage infrastructure allows you to reduce 
the complexity and cost of your storage management. Fully redundant and hot-
swappable components let you to keep applications online, while within-system volume 
replication and incremental copy functions allow for frequent backups. The available 
RAID-6 architecture gives you high availability and rapid RAID group rebuild, while the 
Hi-Track “call home” service and remote maintenance functions provide the security of 
24/7 support from expert service professionals. 

You can partition and dedicate cache to maximize the performance of high-I/O 
operations. You can leverage the AMS or WMS together with the enterprise-class 
TagmaStore Universal Storage Platform (USP) or Network Storage Controller (NSC) to 
implement a tiered storage solution to manage the data lifecycle. Simple SAN and SAN 
Starter solutions allow easy deployment. SAN-attached servers can use diskless boot, and 
Network Attached Storage (NAS) applications allow for high-capacity storage. 
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Chapter 2 Installing Storage Navigator 

This chapter discusses the following topics: 

 Connecting Storage Navigator to the host (section 2.1) 

 System Requirements (section 2.2) 

 Installing Storage Navigator (section 2.3) 

 Updating Storage Navigator (section 2.4) 

 Uninstalling Storage Navigator (section 2.5) 
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2.1 Connecting Storage Navigator to the Host 

You can connect the Storage Navigator to a host through a LAN with or without a hub. 

2.1.1 Connecting Through a LAN with a Hub 

 

Figure 2.1 Connecting to a Host without a Hub 

Note: If an array unit is already connected to a LAN, connect the host to the same 
network. 

2.1.2 Connecting Through a LAN without a Hub 

 

Figure 2.2 Connecting to a Host with a Hub 
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2.2 System Requirements 

2.2.1 Hardware Requirements 

Storage Navigator Modular has the following hardware requirements: 

 Hitachi Storage Navigator Modular subsystem(s) 

 One or more Storage Navigator computers. A web browser is required.  

 LAN cables and connection: 10BaseT/100BaseT. Use twisted pair crossover cable if 
array unit is connected directly to a host; use twisted pair cable if array unit is 
connected via a hub. 

 Network adapter 

 License keys for Storage Navigator and other features. 

 TCP/IP Port. Storage Navigator uses port number 2000. If you change the port 
number, you must add “df-damp-snm port number/TCP” to the OS services, and 
change the port number of the subsystem. When the subsystem port number is set to 
2000, it can be connected to the LAN even if another port number is registered in 
the services file. 

2.2.2 Operating System Requirements 

2.2.2.1 Windows® 

 Operating system: Windows® 98, Windows NT®, Windows® 2000, Windows® XP,  
Windows Server™ 2003 or Windows Server™ 2003 (R2): 

– Windows 98 requires MSIME 98-98-SRI. 

– DirectX version 8.1 or later 

 Processor (CPU): Pentium® II, III, IV (233 MHz or more is recommended.) 

 Monitor: 

– 800 x 600 is required; 1,024 x 768 or more is recommended. 

– 256 colors or more 

 Memory: 256 MB (512 MB or more is recommended.) 

 Available hard drive space: 50.3 MB max (A free capacity of 100 MB or more is 
required.) 

 Web browser 

 Java™ Runtime Environment: j2re-1.4.2_07 
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2.2.2.2 Solaris™ 

 Sun™ server/workstation  

 Operating system: Solaris 7, 8, 9 

 CPU: UltraSPARC or better 

 Memory: 256 MB (512 MB or more is recommended.) 

 Disk capacity: 72.7 MB max (A free capacity of 100 MB or more is required.) 

 Network adapter 

 Monitor: 

– Resolution 800 x 600, 1,024 x 768 or more is recommended. 

– 256 color or more 

– If the screen color is uneven, use the /usr/sbin/fbconfig command with a -
prconf option to enlarge the color depth.  

 LAN connection: 10BaseT/100BaseT. Use twisted pair crossover cable if array unit is 
connected directly to a host; use twisted pair cable if array unit is connected via a 
hub. 

 Java Runtime Environment: J2re 1.4.2_07 

2.2.2.3 SGI® 

 SGI server/workstation 

 Operating system: IRIX® 6.5 

 CPU: R10000 or more is recommended. 

 Memory: 256 MB (512 MB or more is recommended.) 

 Disk capacity: 9.12 MB max (A free capacity of 100 MB or more is required.) 

 Network adapter 

 Monitor: 

– Resolution 800 x 600, 1,024 x 768 or more is recommended. 

– 256 color or more 

 LAN connection: 10BaseT/100BaseT. Use twisted pair crossover cable if array unit is 
connected directly to a host; use twisted pair cable if array unit is connected via a 
hub. 

 Java Runtime Environment: JRE 1.4.1 
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2.2.2.4 HP-UX 

 HP server/workstation 

 HP-UX 11.0 

 CPU: PA8000 or more is recommended. 

 Memory: 256 MB (512 MB or more is recommended.) 

 Disk capacity: 119 MB max (A free capacity of 200 MB or more is required.) 

 Network adapter 

 Monitor: 

– Resolution 800 x 600, 1,024 x 768 or more is recommended. 

– 256 color or more 

 LAN connection: 10BaseT/100BaseT. Use twisted pair crossover cable if array unit is 
connected directly to a host; use twisted pair cable if array unit is connected via a 
hub.  

 Java Runtime Environment: RTE1.4.2_07 

2.2.2.5 Red Hat® Linux®  

 Operating system: Red Hat Linux 7.3, 8.0 

 Kernel version: 

– Red Hat Linux 7.3: 2.4.18-3 

– Red Hat Linux 8.0: 2.4.18-14 

 glibc version: 

– Red Hat Linux 7.3: 2.2.5-34 

– Red Hat Linux 8.0: 2.3.2-4.80.6 

 CPU: Pentium® II, III, IV (233 MHz or more is recommended.) 

 Memory: 256 MB (512 MB or more is recommended.) 

 Disk capacity: 67.6 MB max (Free capacity of 100 MB or more is required.)  

 Network adapter 

 Monitor: 

– Resolution 800 x 600, 1,024 x 768 or more is recommended. 

– 256 color or more 

 LAN connection: 10BaseT/100BaseT. Use twisted pair crossover cable if array unit is 
connected directly to a host; use twisted pair cable if array unit is connected via a 
hub. 

 Java Runtime Environment: J2re 1.4.2_07 
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2.3 Installing Storage Navigator 

2.3.1 General Installation Requirements 

 If you are using a 9200 Storage Array, make sure that the ERROR INF is set to OFF, 
or Storage Navigator could either fail to connect or end abnormally. This is the 
default. 

 Do not install Storage Navigator in a host that is connected to the storage array, 
because a high I/O load could cause a command time-out on the host side or an 
abnormal termination on the Manager side.  

 At least one logical unit must be configured in the array unit, to make all of the 
Storage Navigator functions available.  

 When you install Resource Manager, it overrides the AMS/WMS error monitoring. To 
restore error monitoring to the AMS/WMS, select  
Edit  Modify  Do Not Modify Registration Information. 

 The Storage Navigator GUI program is operated by JAVA. For Windows, Solaris,  
HP-UX, and Red Hat Linux, JRE is packed. 

2.3.1.1 Windows 

1. Start the Storage Navigator computer, then boot up Windows. 

2. Navigate to the stonavm_win directory in the CD ROM and launch the .exe file. 

2.3.1.2 Solaris 

1. Start a Sun server/workstation, and start up a session in the common desktop 
environment. 

2. Create a new directory (e.g., /usr/stonavm) for installing Storage Navigator. Copy 
the SNM-xxxx-S-GUI.tar file, located in the stonavm_sol directory of the provided 
CD-ROM, into the newly created directory. 

(“xxxx” indicates the variable part of the file name) 

3. Extract the SNM-xxxx-S-GUI.tar file. A sample command is as follows:  

tar xvf SNM-xxxx-S-GUI.tar 

4. Log in again. 
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2.3.1.3 IRIX 

1. Start an SGI server/workstation. 

2. Create a new directory e.g., /usr/stonavm) for installing Storage Navigator. Copy the 
SNM-xxxx-I-GUI.tar file, located in the stonavm_irix directory of the provided CD-
ROM, onto the newly created directory. “xxxx” indicates the variable part of the file 
name. 

3. Extract the SNM-xxxx-I-GUI.tar file. A sample command is as follows: 

tar xvf SNM-xxxx-I-GUI.tar 

4. You will need to change scripts in startsnm (a shell script used to start Storage 
Navigator) in the extracted file to set a path to JRE™ in the DEFAULT_JAVAHOME 
variable. This is usually in the installation directory, named approximately as 
follows: JRE™ 1.4.1. For example, if JRE™ has been installed in /usr/local/JRE1.4.1, 
the command would be: 

DEFAULT_JAVAHOME=/usr/local/JRE1.4.1 

5. Log in again. 

2.3.1.4 HP-UX 

1. Start an HP server/workstation. 

2. Create a new directory (example: /usr/stonavm) for installing the Storage 
Navigator. Copy the SNM-xxxx-H-GUI.tar file, in the stonavm_hpux directory of the 
provided CD-ROM, into the created directory on the hard disk drive. “xxxx” indicates 
the variable part of the file name. 

3. Extract the SNM-xxxx-H-GUI.tar file. A sample command is as follows: 

tar xvf SNM-xxxx-H-GUI.tar 

4. Log in again. 

2.3.1.5 Red Hat Linux 

1. Start the Storage Navigator computer, and start up a session in the common desktop 
environment. 

2. Create a new directory (e.g., /usr/stonavm) for installing the Storage Navigator. 
Copy the SNM-xxxx-L-GUI.tar file, in the stonavm_linux directory of the provided 
CD-ROM into the newly created directory. “xxxx” indicates the variable part of the 
file name. 

3. Extract the SNM-xxxx-L-GUI.tar file. A sample command is as follows: 

tar xvf SNM-xxxx-L-GUI.tar 

4. Log in again. 
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2.4 Updating Storage Navigator 

2.4.1 Windows 

1. Stop all instances of Storage Navigator. 

3. Navigate to the stonavm_win directory in the CD ROM and launch the .exe file. 

2. The updated Storage Navigator can be run without restarting Windows. 

2.4.2 Solaris 

1. Stop all instances of Storage Navigator. 

2. Copy the SNM-xxxx-S-GUI.tar file, in the stonavm_sol directory of the provided CD-
ROM, to the hard disk. “xxxx” indicates the variable part of the file name. 

3. Extract the SNM-xxxx-S-GUI.tar file. A sample command is as follows: 

tar xvf SNM-xxxx-S-GUI.tar 

4. The updated Storage Navigator can be run without restarting Solaris. 

2.4.3 IRIX 

1. Stop all instances of Storage Navigator. 

2. Copy the SNM-xxxx-I-GUI.tar file, in the stonavm_irix directory of the provided CD-
ROM, to the hard disk. “xxxx” indicates the variable part of the file name. 

3. Extract the SNM-xxxx-I.tar file. A sample command is as follows: 

tar xvf SNM-xxxx-I-GUI.tar 

4. The updated Storage Navigator can be run without restarting IRIX. 
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2.4.4 HP-UX 

1. Stop all instances of Storage Navigator. 

2. Copy the SNM-xxxx-H-GUI.tar file, in the stonavm_hpux directory of the provided 
CD-ROM, to the hard disk. “xxxx” indicates the variable part of the file name. 

3. Extract the SNM-xxxx-H-GUI.tar file. A sample command is as follows: 

tar xvf SNM-xxxx-H-GUI.tar 

4. The updated Storage Navigator can be run without restarting HP-UX. 

2.4.5 Red Hat Linux 

1. Stop all instances of Storage Navigator. 

2. Copy the SNM-xxxx-L-GUI.tar file, in the stonavm_linux directory of the provided 
CD-ROM, to the hard disk. (“xxxx” indicates the variable part of the file name.) 

3. Extract the SNM-xxxx-L-GUI.tar file. A sample command is as follows: 

tar xvf SNM-xxxx-L-GUI.tar 

4. The updated Storage Navigator can be run without restarting Red Hat Linux. 
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2.5 Uninstalling Storage Navigator 

2.5.1 Windows 

1. Delete Storage Navigator using the Add and Delete Application icon on the Control 
Panel. 

2. Delete the directory used for Storage Navigator from the hard disk drive. 

2.5.2 Solaris, IRIX, HP-UX, and Red Hat Linux 

Remove the Storage Navigator software and delete the directory.  
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Chapter 3 Viewing the Storage Navigator Main Windows 

This chapter discusses the following topics 

 The Storage Navigator Main Window (section 3.1) 

 The Array System Viewer Window (section 3.2) 
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3.1 Storage Navigator Main Window  

The Storage Navigator Main window (see Figure 3.1) displays when you launch Storage 
Navigator. 

 

Task Bar 

Menu Bar 

Tree View Box 

List View Box 

Status Bar 

Tool Bar

 

Figure 3.1 Storage Navigator Main Window 

3.1.1 Menu Bars and Toolbars 

Table 3.1 File Functions 

Menu Tool Bar Function 

Open 
 

Displays the Array System Viewer window. 

Reboot — Reboot the subsystem. 

Exit Terminates Storage Navigator. 

Table 3.2 Edit Functions 

Menu Tool Bar Function 

Add 
 

Registers the subsystem. 

Add Automatically — Registers the subsystem automatically. 

Modify — Changes the registration contents of the subsystem. 

Delete 

 
Deletes the registration of an array unit, which is registered in the 
Storage Navigator. 

Monitoring — Sets the Monitoring Enable or Disable. 
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Table 3.3 View Functions 

Menu Tool Bar Function 

Icon 
 

Displays the property of the subsystem by an icon. 

Detail 
 

Displays the property of the subsystem in detail. 

Refresh — Updates the view to the current subsystem status. 

Table 3.4 Tool Functions 

Menu Tool Bar Function 

Operation Mode Change 
 

Changes the active mode. 

 Set Password — Sets the password. 

Error Monitoring Execution 
 

Executes the error monitoring. 

 Scheduled Execution — Starts the error monitoring. 

 Stop — Stops the error monitoring. 

 Options 
 

Displays the Monitoring Options window. 

 Account — Registers the failure monitoring account. 

Ace Tool  — Navigates the Back-end configuration. 

Table 3.5  Help Functions 

Menu Tool Bar Function 

Version — Displays the revision of the Storage Navigator. 

Table 3.6 Tool Bar Icons 

Menu Tool Bar Function 

Exit 
 

Terminates the Array System Viewer window. 

Properties — Displays the property of the subsystem. 

Drive Configuration — Displays the drive configuration of the subsystem. 

Refresh 
 

Refreshes the Array System Viewer window. 
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Table 3.7 Settings Functions 

Menu Tool Bar Function 

RAID Group Create 
 

Displays the RAID group settings window. 

 Delete — Deletes specified RAID group. 

Logical Unit Create 
 

Displays the logical unit settings window. 

 Format 
 

Formats the logical unit (Max. 6). 

 Change Default Controller — Changes default controller of logical unit. 

 Parity Correction — Corrects the logical unit parity. 

 Delete — Deletes specified logical unit. 

Table 3.8 Tools Functions 

Menu Tool Bar Function 

Wizard 
 

Starts the logical unit wizard. 

Configuration Settings 
 

Displays the configuration settings window. 

Mapping Guard — Displays the LU mapping guard settings window. 

Performance Output File 
 

Outputs the performance of the subsystem. 

 Settings — Sets the collection of performance statistics. 

Statistical Information 
 

Displays the statistics information of the subsystem. 

Information Message — Displays the information message of the subsystem. 

Tuning Parameter — Displays the tuning parameter settings window. 

ACE Tool — Navigates the Back-end configuration. 
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3.1.2 Tree View Box 

 The Tree View box displays names of the registered array units.  

– Double clicking on Group + displays a list of the registered array units in that 
group.  

– Selecting a particular group icon displays the array units for that specific group.  

Table 3.9 RAID Group Icons 

Display Status 

  Blue 
Normal 

  Blue 
Normal 

Table 3.10 Logical Unit Icons 

Display Status 

  Yellow 
Formatted logical unit. 

  Gray 
Unformatted logical unit. 

  Red 
Blockaded logical unit. 

  Pink 
Regressed logical unit. 

  Light Yellow 
Invalidated formatted logical unit. 

  Light Gray 
Invalidated unformatted logical unit. 

  Light Pink 
Invalidated regressed logical unit. 

  Yellow Quick formatted logical unit or quick format standby logical unit. 

  Yellow (9200 only) 
Parity recovered logical unit or parity recovery standby logical 
unit. 
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3.1.3 List View Box 

 The List View box displays icons representing the array group(s) selected in the Tree 
View box. The icon will be one of the following: 

Table 3.11 Icons in List View Box 

 ,     Gray 

Subsystem is booting up, and is not performing error monitoring.  

 ,   Gray +  Blue 

Normal 

 ,   Gray +  Yellow 

Warning 

 ,   Gray 

Subsystem is down, powered off, or there is a communication error.  

Table 3.12 Status Bar Descriptions 

Status Bar Description 

 
Error Monitoring is stopped. 

 
Error Monitoring is running. 

 
Error Monitoring in the interval 
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3.2 Array System Viewer Window 

Access the Array System Viewer window by selecting a storage array in the List View 
box, and then either selecting File  Open or clicking the Open icon ( ) on the tool 
bar. The Component Status tab (see section 3.2.1) is the default view. The Logical 
Status tab (see section 3.2.1.28) is the alternate view. 

To update the component display, select View  Refresh, or click the Refresh icon 
( ) in the tool bar. 

3.2.1 Component Status Tab 

If you click the Component Status tab on the Array System Viewer window, you can 
view the status of various subsystem components.  

3.2.1.1 Subsystem View 

Click the Subsystem icon, to view the status of the components of the entire subsystem, 
see Figure 3.2. 

 

Figure 3.2 Component Status Tab, Subsystem View 
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3.2.1.2 Controller View 

Click the Controller icon, to view the controller status, see Figure 3.3 

 

Figure 3.3 Component Status Tab, Controller View 

– Controller: Controller No. 

– Status: Status: 

– Normal: Normal 

– Warning: Cache or Battery Backup failure 

– Detach: Detached 

– Reconst: Reconfiguring 

Table 3.13 Controller Icons 

Display Status 

  Green Normal 

  Yellow Failure 

  Red 
Blockade 
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3.2.1.3 Cache View 

Click the Cache icon, to view the detailed status of the cache, see Figure 3.4. 

 

Figure 3.4 Component Status Tab, Cache View 

– Controller: Controller No. 

– Slot: Slot No. 

– Capacity: Cache memory capacity 

– Status: Status: 

– Normal: Normal 

– Detached: Detached 

– Nothing: Not installed 
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Table 3.14 Cache Icons 

Display Status 

  Blue 
Normal 

  Red 
Failure 

 
Not installed 

3.2.1.4 Battery Backup View 

Click the Battery Backup icon, to view the detailed status of the battery backup, see 
Figure 3.5. 

 

Figure 3.5 Component Status Tab, Battery Backup View 

– Controller: Controller No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 
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Table 3.15 Battery Backup Icons 

Display Status 

  Blue Normal 

  Yellow Failure 

3.2.1.5 Battery View 

Click the Battery icon, to view the detailed status of the battery, see Figure 3.6. 

 

Figure 3.6 Component Status Tab, Battery View 

– Battery: Battery No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 
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Table 3.16 Battery Icons 

Display Status 

  Blue Normal 

  Red Failure 

3.2.1.6 Drive View 

 

Figure 3.7 Component Status Tab, Drive View 
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– Unit: Unit No. 

– HDU: HDU No. 

– Type: Drive using form: 

– Data: Data drive 

– Spare: Spare drive 

– Undefine: Normal (LU not defined) 

– Capacity: Storage capacity of a drive 

– Drive Type: Drive type (FC or SATA) 

– Status: Drive status: 

– Normal: Normal 

– Detached: Blockade 

– Detached (Unmount): The drive in the blockade status is not installed. 

– Standby: Normal (LU not defined) 

– Out of RG: Normal (RAID not defined) 

– Unmount: The drive is not installed. 

– Recovery: Under recovery (correction copy or copy-back in progress) 

– Waiting: Spare drive not used 

– Vendor ID: Vendor ID of drive (display determined by drive mounting and 
status) 

– Product ID: Product ID of drive (display determined by drive mounting and 
status) 

– Revision: Drive firmware revision (display determined by drive mounting and 
status) 

– Serial No.: Serial No. of a drive (display determined by drive mounting and 
status) 

Table 3.17 Data Drive Icons  

FC Drive SATA Drive Status 

  Purple  
 Normal (there is a formatted LU) 

  Yellow  
 Collection reconstruction status 
 Copy-back status from the spare disk 

  Red  
 Blockade. Disk Drive is blocked. 

  Gray  
 RAID group defined, LU not defined 
 LU defined, unformatted 

  Red + Black  
 Not mounted in the blockade status 

  Purple + Black  
 RAID group defined, drive not mounted 

   RAID group not defined, drive mounted 

          No indication   RAID group not defined, drive not mounted 
 Not supported location 
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If you right-click on a drive in the Drive View and select Display Drive Configuration, 
the Drive Configuration window displays a detailed view of the selected drive 
(see Figure 3.8). 

 

Figure 3.8 Drive Configuration Window 
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3.2.1.7 Fan View 

Click the Fan icon, to view the detailed status of the fan, see Figure 3.9 

 

Figure 3.9 Component Status Tab, Fan View 

– Unit: Unit No. 

– Fan: Fan No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.18 Fan Icons 

Display Status 

  Black Normal 

  Red Failure 
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3.2.1.8 AC View 

Click the AC icon, to view the detailed status of the AC, see Figure 3.10. 

 

Figure 3.10 Component Status Tab, AC View 

– Unit: Unit No. 

– AC: AC No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 
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3.2.1.9 ENC View 

Click the ENC icon, to view the detailed status of the ENC, see Figure 3.11. 

 

Figure 3.11 Component Status Tab, ENC View 

– Unit: Unit No. 

– ENC: ENC No. 

– Type: Enclosure type (ENC or SENC) 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.19 Enclosure/SENC Icons  

ENC SENC Status 

  Green  Normal 

  Red  Failure 

Note: AT displayed at the upper left of an icon indicates a SENC. 
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3.2.1.10 Loop View 

Click the Loop icon, to view the detailed status of the loop, see Figure 3.12. 

 

Figure 3.12 Component Status Tab, Loop View 

– Path: Path No. 

– Loop: Loop No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.20 Loop Icons 

Display Status 

  Blue 
Normal 

  Red 
Failure 
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3.2.1.11 SATA Units View 

Click the Units icon, for a general view of the SATA units in the subsystem, see Figure 
3.13. 

 

Figure 3.13 Component Status Tab, Units View 
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3.2.1.12 Individual SATA Unit View 

Click the icon for an individual unit, to view the status of that SATA unit, see Figure 
3.14. The status icons for the individual components are the same as those for the 
subsystem box, which were previously discussed in sections 3.2.1.1 through 3.2.1.10. 

 

Figure 3.14 Component Status Tab, Individual SATA Unit View 
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3.2.1.13 NNC View 

Click the NNC icon, for an overall view of the status of the NNC components, see Figure 
3.15. 

 

Figure 3.15 Component Status Tab, NNC View 

Table 3.21 NNC Icons 

Display Status 

  Gray Normal 

  Gray+Yellow Alarm 

  Red Blockade 
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3.2.1.14 Individual NNC (NNC Type2) Unit View 

Select the individual NNC unit icon to view its status. See Figure 3.16. 

 

Figure 3.16 Component Status Tab, Individual NNC (Type2) Unit View 
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3.2.1.15 NNC Base View 

 

Figure 3.17 Component Status Tab, NNC Base View 

– NNC: NNC No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.22 NNC Base (Type2) Icons 

Display Status 

  Green Normal 

  Red Failure 
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3.2.1.16 NNC (Type2) DIMM View 

 

Figure 3.18 Component Status Tab, DIMM (Type2) View 

– NNC: NNC No. 

– DIMM: DIMM No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.23 NNC DIMM (Type2) Icons 

Display Status 

  Green Normal 

  Red Failure 
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3.2.1.17 NNC (Type2) PS View 

 

Table 3.24 Component Status Tab, NNC (Type2) PS View 

– NNC: NNC No. 

– PS: PS No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.25 NNC PS (Type2) Icons 

Display Status 

  Blue Normal 

  Red Failure 
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3.2.1.18 NNC (Type2) Fan View 

 

Figure 3.19 Component Status Tab, NNC (Type2) Fan View 

– NNC: NNC No. 

– Fan: Fan No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.26 NNC (Type2) Fan Icons 

Display Status 

  Black Normal 

  Red Failure 
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3.2.1.19 NNC (Type2) Extension Slot 

 

Figure 3.20 Component Status Tab, NNC (Type2) Extension Slot View 

– NNC: NNC No. 

– Extension Slot: Extension Slot No. 

– Extension Card: Extension Card type 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.27 NNC (Type2) Extension Slot Icons 

Display Status 

  Gray Normal 

  Red Failure 
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3.2.1.20 NNC (Type2) Extension Slot3 

 

Figure 3.21 Component Status Tab, NNC (Type2) Extension Slot3 View 

– NNC: NNC No. 

– Parts: Parts type 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.28 NNC (Type2) Extension Slot Icons 

Display Status 

  Gray Normal 

  Red Failure 
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3.2.1.21 NNC (Type2) Extension Card 

 

Figure 3.22 Component Status Tab, NNC (Type2) Extension Card View 

– NNC: NNC No. 

– Extension Slot: Extension Slot No. 

– Extension Card: Extension Card type 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.29 NNC (Type2) Extension Card Icons 

Display Status 

  Green Normal 

  Red Failure 
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3.2.1.22 NNC (Type2) Host Connector 

 

Figure 3.23 Component Status Tab, NNC (Type2) Host Connector View 

– NNC: NNC No. 

– Extension Slot: Extension Slot No. 

– Host Connector: Host Connector No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.30 NNC (Type2) Host Connector Icons 

Display Status 

  Gray Normal 

  Red Failure 
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3.2.1.23 Individual NNC (Type1) Unit View 

Click the icon for an individual NNC unit, to see the status of that NNC unit, see Figure 
3.24. 

 

Figure 3.24 Component Status Tab, Individual NNC (Type1) Unit View 
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3.2.1.24 NNC (Type1) DIMM View 

 

Figure 3.25 Component Status Tab, DIMM (Type1) View 

– NNC: NNC No. 

– DIMM: DIMM No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.31 NNC (Type1) DIMM Icons 

Display Status 

  Green Normal 

  Red Failure 
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3.2.1.25 NNC (Type1) PS View 

 

Figure 3.26 Component Status Tab, NNC (Type1) PS View 

– NNC: NNC No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.32 NNC PS (Type1) Icons 

Display Status 

  Blue Normal 

  Red Failure 
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3.2.1.26 NNC (Type1) Fan View 

 

Figure 3.27 Component Status Tab, NNC (Type1) Fan View 

– NNC: NNC No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.33 NNC (Type1) Fan Icons 

Display Status 

  Black Normal 

  Red Failure 
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3.2.1.27 NNC (Type1) Host Connector View 

 

Figure 3.28 Component Status Tab, NNC (Type1) Host Connector View 

– NNC: NNC No. 

– Status: Status: 

– Normal: Normal 

– Alarm: Failure 

Table 3.34 NNC Host (Type1) Connector Icons 

Display Status 

  Gray Normal 

  Red Failure 
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3.2.1.28 Property Window 

To display the Property window, from the Components tab, select View  Properties. 

 

Figure 3.29 Property Window 
 

– Array Unit Type: Subsystem type 

– Construction: Configuration type of the subsystem 

– Serial Number: Serial number of the subsystem 

– Microcode Revision: Micro program revision of the subsystem 

– Controller No.: Controller No. 

– IP Address: IP address of each controller 

– Subnet Mask: Subnet Mask of each controller 

– Default Gateway: Default gateway of each controller 
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3.2.2 Logical Status Tab 

Click the Subsystem icon, to view the logical status of the entire subsystem, see Figure 
3.30 

 

Figure 3.30 Array System Viewer Window, Logical Status Tab  
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3.2.2.1 RAID Groups View 

Click the RAID Groups icon, to view the logical status of all RAID groups in the 
subsystem, see Figure 3.31. 

 

Figure 3.31 Logical Status Tab, RAID Groups View 
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3.2.2.2 Individual RAID Group View 

Select an individual RAID group to view the status of that group, see Figure 3.32. 

 

Figure 3.32 Logical Status Tab, Individual RAID Group View 
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3.2.2.3 Targets View 

 

Figure 3.33 Logical Status Tab, Targets View 
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3.2.2.4 Individual Target Port View 

 

Figure 3.34 Logical Status Tab, Individual Target Port View 
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3.2.2.5 Access Mode View 

 

Figure 3.35 Logical Status Tab, Access Mode View 
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3.2.2.6 Mapping Mode View 

 

Figure 3.36 Logical Status Tab, Mapping Mode View 
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3.2.2.7 Target Security View 

 

Figure 3.37 Logical Status Tab, Target Security View 
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3.2.2.8 Spare Drives View 

 

Figure 3.38 Logical Status Tab, Spare Drives View 

Table 3.35 Spare Drive Icons 

FC Drive SATA Drive Status 

  Purple  
 Spare drive in use 

  Yellow  
 Data reconstruction to spare drive 
 Copy-back from spare disk to data disk 

  Purple + Black  
 Waiting 

  Red  
 Busy or Disk Drive Detached for Restoring 

  Red + Black  
 Spare disk not mounted though Use of Spare Disk is set as 

subsystem 

Note: AT displayed at the upper left of an icon indicates a SATA drive. 
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3.2.2.9 Differential Management LU View 

 

Figure 3.39 Logical Status Tab, Differential Management LU View 
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3.2.2.10 Command Devices View 

 

Figure 3.40 Logical Status Tab, Command Devices View 
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3.2.2.11 License Key View 

 

Figure 3.41 Logical Status Tab, License Key View 
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3.2.2.12 ShadowImage View 

 

Figure 3.42 Logical Status Tab, ShadowImage View 
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Figure 3.43 Logical Status Tab, ShadowImage Pair View 
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3.2.2.13 LUN Expansion View 

 

Figure 3.44 Logical Status Tab, LUN Expansion View 
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3.2.2.14 Data Retention View 

 

Figure 3.45 Logical Status Tab, Data Retention View 
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3.2.2.15 Cache Residency View 

 

Figure 3.46 Logical Status Tab, Cache Residency View 
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Chapter 4 Preparing for Storage Navigator Operations 

This chapter discusses the following topics: 

 Using Storage Navigator (section 4.1) 

 Available Storage Navigator functions (section 4.2) 

 Starting and Stopping Storage Navigator (section 4.3) 

 Restarting the subsystem (section 4.4) 

 Changing operation mode (section 4.5) 

 Managing passwords (section 4.6) 

 Configuring subsystems (section 4.7) 

 Displaying an information message (section 4.8) 

 Setting and releasing spare drives (section 4.9) 

 Setting and releasing the differential management LU (section 4.10) 

 Setting and releasing command devices (section 4.11) 

 Enabling and disabling the license key for optional products (section 4.12) 



 

68 Chapter 4 Preparing for Storage Navigator Operations 

4.1 Using Storage Navigator 

Please note the following 

 If you are using Windows®, you must disable Windows power management so that the 
PC does not enter the low power mode suspension state. 

 Close all Array System Viewer windows when you are performing error monitoring.  

 If you update the display after certain operations or by selecting refresh, some host 
group names in the tree view are displayed with “…” in the suffix. 

Example: “000:HG0A-000  000:HG0A…” 

Execute refresh or expand the tree again, and the tree view will display the hidden 
information. 

 When connecting the disk array subsystem with Storage Navigator via a LAN, 
depending on the LAN environment, the disk array subsystem may not be connected 
due to data transfer time-out. When Storage Navigator cannot connect with the disk 
array subsystem, verify that the connection is correct by using the ping command, 
etc. If the response to the ping command is normal, the LAN environment may 
affect the data transfer. The length of data to be transferred can be changed with 
the lanconf.inf file in the directory in which Storage Navigator is installed. The 
default setting is 32768. Change the setting to 16384 or 8192 in that order, or to a 
multiple of 1024, and then retry. The new setting becomes effective during the 
next operation (restarting Storage Navigator is not required). Storage Navigator 
operations may take extensive time, depending on the setting. If the connection 
cannot be made after the settings are changed, review the LAN environment. 

 Do not use the reserved words discrete for each OS or device names that indicate the 
input/output destinations as a file name when a file is output. Windows includes 
“con”, “pm”, “aux”, etc. and UNIX® includes “/dev*”, etc. For example, when 
con.txt is specified as an output file name, an error message is displayed in a 
window. 

 If you are connecting Storage Navigator to a subsystem using a LAN, the TCP/IP port 
number is 2000. If you are using version 0726/E or later, this port can be changed. If 
you cannot connect, verify the TCP/IP port number. See section 5.4 for more 
information on configuring the port number. 

 If the subsystem has Account Authorization enabled and it either terminates 
abnormally or does not respond within the normal session time-out, do one of the 
following: 

– If a confirmation message has displayed, respond to the message. 

– If no confirmation message displays, re-log in to the subsystem. 
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Table 4.1 lists the restrictions on concurrent use of other programs.  

Table 4.1 Restrictions on using Multiple Management Programs for Single Array  

Program Name Concurrent Use Supported Concurrent Use Not Supported 

Storage Navigator Modular   Storage Navigator Modular (Note) 
 SNMP Agent 
 zWeb Server 

 DAMP GUI 
 DAMP for Web 

DAMP GUI  SNMP Agent 
 DAMP Web Server 

 Storage Navigator Modular 
 DAMP GUI 
 DAMP for Web 

DAMP (Web)  SNMP Agent 
 DAMP Web Server 

 Storage Navigator Modular 
 DAMP GUI 
 DAMP for Web 

SNMP Agent  Storage Navigator Modular 
 DAMP GUI  
 DAMP for Web 
 SNMP Agent 
 DAMP Web Server 

 

Disk Array Unit Web Server  Storage Navigator Modular 
 DAMP GUI  
 DAMP for Web 
 SNMP Agent 
 DAMP Web Server 

 

Note: You can have two concurrent instances of Storage Navigator Modular, provided 
that they are not connected to the same array system. If one instance terminates 
forcibly, that may affect the other instance.  



 

70 Chapter 4 Preparing for Storage Navigator Operations 

4.2 Available Storage Navigator Functions 

Table 4.2 lists the available functions for Storage Navigator. The functions that are 
available are determined by whether you are in normal mode or management mode. 
Normal mode is the default, but you can change it in the startup window before you 
connect to the storage array. Except for error monitoring, you should not operate 
Storage Navigator while you are online, because your connection may time out. 

Table 4.2 Storage Navigator Functions (continued on the following pages) 

Category Function 
Name 

Description Usability 
During 
Operation 

Normal 
Mode 

Management 
Mode 

Configuration 
display 

Component 
status display 

Displays the status of a 
component such as drive and 
fan by using an icon. 

Yes Yes Yes 

 Property 
display 

Displays the status about system 
components of an array unit, 
RAID, logical units, etc. 

Yes Yes Yes 

RAID group 
creation 

Used to add a RAID group. You 
can set a new RAID group by 
specifying its disk number, RAID 
level, and group range for the 
RAID group to be created. 

Yes No Yes RAID group 
definition 

RAID group 
deletion 

Deletes a defined RAID group or 
a specified RAID group. User 
data is deleted. 

No No Yes 

LU definition LU creation Used to add a logical unit (LU). 
A new logical unit is added by 
specifying its capacity. Must be 
added in numerical order. 

Yes No Yes 

 LU deletion Deletes the last defined logical 
unit (LU). User data is deleted. 

No No Yes 

 LU formatting Required to make a defined 
logical unit (LU) accessible by 
the host. Writes null data to the 
specified logical unit, and deletes 
user data.  

No /Yes No Yes 

 Change of 
default 
controller in 
charge of an 
LU 

Used to change the default 
controller in charge of an logical 
unit (LU) as follows: 
CTL0  CTL1 and 
CTL1  CTL0 
Array unit must be restarted to 
implement the setting. 

Yes No Yes 

 Parity 
Correction 

Restore the logical unit in which 
the parity error has occurred. 

Yes No Yes 

Setting the 
selection 

LU creation Creation of the logical units using 
a Wizard 

Yes No Yes 
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Category Function 

Name 
Description Usability 

During 
Operation 

Normal 
Mode 

Management 
Mode 

Setting up 
spare disk 
drive 

Sets up spare disk drives. Yes No Yes 

Differential 
Management 
LU 

Sets up the differential 
management LU 

Yes No Yes 

Command 
device 

Sets up the command devices Yes No Yes 

Setting the 
selection 

Setup and 
display of the 
priced optional 
features  

Opens/closes the priced optional 
features key and sets and 
displays the enable/disable 
condition. 

Yes No Yes 

Setting the 
boot option 

Sets up the boot option. 
Subsystem must be restarted to 
implement the setting. 

No No Yes 

Setting and 
display of the 
Fibre Channel 
information 

Sets and displays port addresses 
and security information, etc. 

No No Yes 

System 
parameter 

Sets up the System parameters. Yes No Yes 

Port option Sets up the port options. Yes No Yes 

Setting the 
drive 
restoration 
option 

Use the default mode unless 
necessary or you could affect 
performance. Sets automatic or 
non-automatic start for the 
following:  
 Drive restoration mode  
 Start of copy-back 
 Start of correction copy,  
 Time interval restoring 

processing unit size 
 Dynamic sparing mode. 

No No Yes 

Configuration 
Setting 

On-line verify 
setting 

Determines whether the online 
verify setting is on or off, and 
sets the interval. Use caution, or 
performance could be affected.  

No No Yes 

 LAN 
configuration 
information 
setting 

Sets the IP Address, Sub Net 
Mask, Default Gateway Address, 
and the DHCP mode. 

Yes No Yes 

 Setup and 
display of RTC 

Sets and displays the date and 
time. 

Yes No Yes 
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Category Function 

Name 
Description Usability 

During 
Operation 

Normal 
Mode 

Management 
Mode 

Configuration 
Setting 

Configuration 
information file 
output and its 
setup by use 
of a file. 

Outputs system parameters and 
RAID group/logical unit 
configuration information to a file 
individually. Sets system 
parameters and RAID 
group/logical unit configuration 
information using a file. 
Subsystem must be restarted to 
implement the settings. Deletes 
user data.  

Yes Yes Yes 

 Microcode 
replacement 

Downloads and updates the 
microcode of the subsystem. 
Subsystem must be restarted to 
implement the settings. 

No / Yes No Yes 

Statistical 
information 
display 

Controller use 
information 
display 

Displays previous statistical 
information by selecting a related 
item. 

Yes Yes Yes 

Performance Command 
operation 
status display 

Outputs the command operation 
status during a certain period or 
a specified period to the file in 
the text format. 

Yes Yes Yes 

Error 
monitoring 

Report when a 
failure occurs 
and controller 
status display 

Polls the subsystem and displays 
the status. If an error is detected, 
it is output into a log file and sent 
by e-mail. A specified application 
is started. Contact the Hitachi 
Data Systems Technical Support 
Center for any failures.  

Yes Yes Yes 
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4.3 Starting and Stopping Storage Navigator 

4.3.1 Launching from Windows 

4.3.1.1 Launching from Installation Directory 

1. Either double click the Storage Navigator - Modular icon ( ) on the desktop, or 
from the Start menu, select Programs then Storage Navigator - Modular. When the 
startsnm.bat file is executed, Storage Navigator starts. 

Note: When Storage Navigator is used on Windows 98, 2000, or XP, an error may 
occur in which the menu display is disabled by a menu bar operation with the mouse. 
If this occurs, disable the pointer trail or the pointer shadow for the Mouse 
properties in the Control Panel.  

2. If the menu still does not display, disable the Scheme for the Pointers tab in the 
Mouse properties. It is also possible that the menu display may be disabled due to 
erroneous settings.  

3. If the menu still does not display, set the color properties value to 65536 or less. It is 
also possible that the menu display may be disabled due to erroneous settings. If the 
menu display remains disabled, set the color properties value to 65536 or less. 

4. The Storage Navigator program starts in normal mode and the Main panel appears. 

Example: 

If the Storage Navigator has been installed in C:\Storage Navigator Modular GUI: 

set STONAVM_HOME=C:\Storage Navigator Modular GUI  

java –classpath .\stonavm.jar;.\AceTool.jar  

jp.co.Hitachi.str.diskarray.gui.ConmanFrame %1 %2 %3 %4 %5 %6 %7 %8 

WARNING: The command prompt is displayed. Although it is not related to Storage 
Navigator options, do not close it, or Storage Navigator will terminate forcibly. If you do 
not need it, minimize it.  
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4.3.1.2 Launching from a Different Directory 

Edit the STONAVM_HOME environment variable of startsnm.bat in the extracted file. 

1. Set up the Storage Navigator installation in the STONAVM_HOME variable 
environment. 

Note: When the Storage Navigator program is started from a batch file, use the 
Storage Navigator installation directory. When Storage Navigator is used on Windows 
98, it may terminate abnormally due to an insufficient area for the environmental 
variable, etc. 

2. If activation fails, change a property of startsnm.bat. To change it, open the 
property and set the Initial environment of the Memory tab for 1,024. 

3. The Storage Navigator program starts in normal mode and the Main window displays. 

4.3.1.3 Specifying Automatic Launch of Error Monitoring 

You automatically start error monitoring on startup by modifying the startup.bat file. 
This only works for Windows. 

1. Open the bat file to boot the Storage Navigator. 

2. Specify the -check option in the startsnm.bat file (see Figure 4.1). 

3. Prepare a shortcut to the Storage Navigator startup bat file for the “Startup”. 

4. When Windows is rebooted, Storage Navigator is started in an error monitoring 
executing status. 

java -classpath .\stonavm.jar;.\AceTool.jar  
jp.co.hitachi.str.diskarray.gui.ConmanFrame  %1 %2 %3 %4 %5 %6 %7 %8 -check 

Parameter for error monitoring 
 

Figure 4.1 Editing the Startsnm.bat File 
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4.3.1.4 Specifying Automatic Display of Array System Viewer Window 

You can automatically display the Array System Viewer window (see Figure 3.30) on 
startup by modifying the startsnm.bat file. This only works for Windows.  

1. When the Storage Navigator is started, the bat file is opened. 

2. Specify the following options in the execution file of the bat file. 

– unit: Registered name of the subsystem (see Figure 4.2) 

– ip: IP address of controller 0 or controller 1 of the registered the subsystem 
(see Figure 4.3) 

– host: Host name of controller 0 or controller 1 of the registered the subsystem 
(see Figure 4.4) 

java -classpath .\stonavm.jar;.\AceTool.jar  
jp.co.hitachi.str.diskarray.gui.ConmanFrame  %1 %2 %3 %4 %5 %6 %7 %8 -unit DF700M 

Parameter for screen display 

Name of the subsystem to be display 
 

Figure 4.2 Sample Unit Option 

java -classpath .\stonavm.jar;.\AceTool.jar 
jp.co.hitachi.str.diskarray.gui.ConmanFrame %1 %2 %3 %4 %5 %6 %7 %8 -ip 192.168.1.100 

Parameter for screen display 

IP address of the subsystem to be display 
 

Figure 4.3 Sample IP Option 

java -classpath .\stonavm.jar;.\AceTool.jar 
jp.co.hitachi.str.diskarray.gui.ConmanFrame %1 %2 %3 %4 %5 %6 %7 %8 -host DF700M 

Parameter for screen display 

Host name of the subsystem to be display 
 

Figure 4.4 Sample Host Option 
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4.3.2 Launching from Solaris™, IRIX®, HP-UX, or Red Hat® Linux® 

4.3.2.1 Launching from Installation Directory 

Launch the startsnm shell script from the Storage Navigator installation directory. 

Example: 

If Storage Navigator has been installed in /usr/stonavm: 

#STONAVM_HOME environment variable 

STONAVM_HOME=/usr/stonavm 

export STONAVM_HOME 

4.3.2.2 Launching from a Different Directory 

1. Edit the STONAVM_HOME environment variable of startsnm in the extracted file 
before logging in again. 

2. Set up the install directory of Storage Navigator in the STONAVM_HOME environment 
variable. 

Note: Depending on the environment setting of the server/workstation, correct 
character fonts may not be displayed on window. The standard font size is 12. If the 
characters are not displayed correctly, set the font to a different size. To complete 
this setting, insert a one space character, following the last line $JAVABIN 
$EXECJAVA in startsnm, and add “-xfont#” (#: a font size). 

4.3.3 Stopping Storage Navigator 

To stop Storage Navigator, close the Array System Viewer window, then either select on 
File  Exit, or click the Exit icon ( ) on the tool bar.  
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4.4 Restarting the Subsystem 

WARNING: Rebooting requires stopping I/O from the host.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are 
required to reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. 
When restarting the subsystem, you must restart the clusters. 

To restart the subsystem: 

1. On the Storage Navigator Main window, click the icon of a subsystem, then select 
File  Reboot. 

2. Rebooting requires stopping I/O from the host. If you are using TrueCopy or 
TrueCopy Extended Distance, change the pair status to PSUS before you reboot. Stop 
I/O from the host and click OK on the confirmation messages.  

3. Restarting should take between 4 and 15 minutes. Click OK on the confirmation 
message when the restart is complete.  

4.5 Changing Operation Mode 

Storage Navigator has two operation modes:  

– Normal mode allows you to view the subsystem configuration and status. 

– Management mode allows you to view the subsystem configuration and status, 
and set the subsystem configuration. 

4.5.1 Changing from Normal Mode to Management Mode 

When you log into Storage Navigator in Normal mode, Normal Mode is displayed in 
Operation Mode in the upper part of the Main window. 

To change from Normal mode to Management mode: 

1. Either select Tool  Operation Mode  Change, or click the Change Operation 
Mode icon ( ) in the tool bar 

2. Enter your password on the Management Mode Password window (see Figure 4.6) 
and click OK. 

3. Management Mode will display on the window (see Figure 4.7).  

 

Figure 4.5 Normal Mode 
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Figure 4.6 Management Mode Password Window 

 

Figure 4.7 Management Mode 
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4.5.2 Changing from Management Mode to Normal Mode 

To change from Management mode to Normal mode: 

1. Either select Tool  Operation Mode  Change, or click the Change Operation 
Mode icon ( ) in the tool bar. 

2. Click OK on the User Mode Change confirmation dialog box (see Figure 4.8).  

3. Normal Mode will display on the window.  

 

Figure 4.8 User Mode Change Confirmation Dialog Box 
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4.6 Managing Passwords 

Before undertaking any Storage Navigator operations, you must first register a password. 

4.6.1 Registering or Changing a Password 

To register or change a password: 

1. Open the Storage Navigator Main window (see Figure 3.1) and change to Management 
mode.  

2. On the Tool menu, select Operation Mode  Set Password (see Figure 4.9). 

3. The Password window displays (see Figure 4.10). 

4. Enter the new password twice, using up to 12 alphanumeric characters, and click 
OK. 

 

Figure 4.9 Set Password Pop-up Menu 

 

Figure 4.10 Password Window 

4.6.2 Deleting the Password 

To delete the password, you must uninstall and reinstall the Storage Navigator. Refer to 
sections 2.5 for instructions on uninstalling Storage Navigator, and section 2.3 for 
instructions on installing Storage Navigator. 

Note: To save the information of the registered array unit, back up the utlprm.inf file 
and utlprm2.inf file the Storage Navigator installation directory. Reinstall Storage 
Navigator in the same directory, the restore the files to the installation directory. 
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4.7 Configuring Subsystems 

Before undertaking any Storage Navigator operations, you must first register one or more 
storage array units. 

WARNING: If Resource Manager 9500V/9520V for Web (Web DAMP) is installed, Storage 
Navigator Modular cannot recognize the subsystem unless you do the following before 
you register the subsystem with Storage Navigator Modular. 

1. Install Storage Navigator Modular. 

2. Copy utlprm.inf from the Web DAMP folder (typically C:\Program Files\DA Manager 
Web) to the Storage Navigator Modular Web installation folder (typically C:\Program 
Files\Storage Navigator Modular Web). 

3. Start Storage Navigator Modular. 

4. Enter Management mode. 

5. From the Edit menu, select Modify. The Modify Array Unit window displays. 

6. Click OK. 

4.7.1 Adding Subsystems Manually 

1. Open the Storage Navigator Main window (refer to Figure 3.1) and change to 
Management mode. 

2. Open the Add Array Unit window by one of the following methods: 

– On the Edit menu, click Add.  

– On the toolbar, click Add ( )  

– If you already have a registered subsystem, from the List view box, right-click on 
a subsystem icon and click Add. 

3. For a simple registration, the TCP/IP Simple Connection dialog box is displayed. 
Input the IP address of the controller 0 and/or controller 1 and click OK.  

4. For a detailed registration, click Detail and input the following information: 

– Select TCP/IP.  

Note: RS232C is not supported on the AMS/WMS.  

– Input the IP Address or Host Name or Port.  

Note: If you have a dual system, specify the information for the connected 
controller side only.  

– Name: Specify the registered name of the subsystem, up to 16 alphanumeric 
characters or characters (-, _, @, ., space code) except numbers. 

– Group: Specify up to 16 alphanumeric characters or characters except numbers 
(-, _). This is only necessary if two or more subsystems are being controlled as a 
group. The maximum registered number of groups is 200. 

– Error Monitoring: Specify whether or not to perform error monitoring. 

– Check (ON display): Error monitoring 

– No check (OFF display): No error monitoring 

5. Click OK to register the information, and then click OK on the confirmation message.  
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6. The Storage Navigator Main window displays the updated information. 

 

Figure 4.11 Add Array Unit Window (Simple) 

  

Figure 4.12 Add Array Unit Window (Detailed) 
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4.7.2 Adding Subsystems Automatically 

1. Open the Storage Navigator Main window (refer to Figure 3.1) and change to 
Management mode. 

2. Open the Add Array Unit Automatically window by selecting Edit  Add 
Automatically (see Figure 4.13).  

3. In the Search Array Unit window, enter the range of IP addresses in the From and 
To boxes and click Start.  

Note: This will search your entire network, so this could take some time.  

4. The search results will be displayed once the search is finished (see Figure 4.14). In 
the Add Array Unit window, select the name you want to register and click the 

 button to move the selected subsystem from the Search Results list to the 
Array Units to Add list. 

5. Click OK to implement the action, and then click Close on the confirmation message. 

 

Figure 4.13 Add Array Unit Automatically Window (before search) 
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Figure 4.14 Add Array Unit Automatically Window (search results shown) 

 

Figure 4.15 Add Array Unit Automatically Window (unit selected) 
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4.7.3 Modifying Array Unit Properties 

1. On the Storage Navigator Main window, open the Modify Array Unit window (see 
Figure 4.16) by one of the following methods: 

– On the Edit menu, select Modify. 

– Right-click on a registered subsystem, and select Modify. 

2. Modify the registration as desired, click OK to implement the changes, and then click 
OK on the confirmation message. 

 

Figure 4.16 Modify Array Unit Window 

4.7.4 Deleting a Registered Subsystem 

1. Select a subsystem icon on the Storage Navigator, and do one of the following: 

– On the Edit menu, click Delete.  

– Click the Delete icon ( )in the tool bar 

– Right-click the subsystem and select Delete. 

2. Click OK to implement the change, and then click Close on the confirmation 
message.  

4.7.5 Displaying Storage Navigator Version 

1. On the Help menu, select Version to display the Version window. 

2. Click OK to return to the main window. 
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4.8 Displaying Information Message 

1. Display the Information Message dialog box (see Figure 4.17) by one of the following 
methods: 

– From the Storage Navigator Main window, select Tools  Information Message. 

– Click a lamp icon ( ) in the Array Unit window. 

2. Fault and status information are displayed in the appropriate box  

Note: If you are using IRIX, do not select the center mouse button, because you could 
accidentally copy a character string from your clipboard onto the dialogue box. If this 
occurs, close and then re-open the dialogue box.  

 

Figure 4.17 Information Message Dialog Box 
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4.9 Setting and Releasing Spare Drives 

4.9.1 Setting a Spare Drive 

To set up a spare drive: 

1. Click the Logical Status tab on the Array System Viewer window (see Figure 4.18). 

2. From the Tree View, click the Spare Drives icon, and then click Set on the lower 
right of the window to display the Spare Drives Settings window (see Figure 4.19). 

3. In Available Drives list, select HDU number you want to set the spare drives, and 
click the  button. The selected HDU number moves to the Drives to Set list 
(see Figure 4.20). 

4. Click OK to implement the change, and then click OK on the confirmation message. 

5. The Result window is displayed. Click Close. 

 

Figure 4.18 Selecting a Spare Drive 
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Figure 4.19 Spare Drives Settings Window 

 

Figure 4.20 Spare Drive Selected 
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4.9.1.1 Releasing a Spare Drive 

To release a spare drive: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. From the Tree View, click the Spare Drives icon (refer to Figure 4.18). 

3. Select the desired hard drive unit (HDU), and click Release on the lower right of the 
window. 

4. Click OK on the confirmation message. 

5. The Result window is displayed. Click Close. 
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4.10 Setting and Releasing the Differential Management LU 

You will need to set a Differential Management LU, which stores the differential data 
when the volume is copied. The Differential Management LU is treated in the same way 
as the other logical units, but is not recognized by the host because it is hidden. 

The minimum size of a Differential Management LU is 5 GB, and you can set either one or 
two LUs. If you set two, the second one is used for mirroring.  

4.10.1 Setting the Differential Management LU 
1. On the Array System Viewer window, click the Logical Status tab (see Figure 3.30). 

2. Click the Differential Management LU icon (see Figure 4.21) 

3. Click Set. 

4. The Select Logical Unit window displays (see Figure 4.22). 

5. Select the desired LUN, and click OK to implement the change.  

6. Click OK on both confirmation messages. 

7. The Logical Status tab will display the changes (see Figure 4.23) 

 

Figure 4.21 Selecting a Differential Management LU 
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Figure 4.22 Select Logical Unit Window 

 

Figure 4.23 Differential Management LU Set 

4.10.2 Releasing a Differential Management LU 
1. On the Array System Viewer window, click the Logical Status tab (see Figure 3.30). 

2. Click the Differential Management LU icon (see Figure 4.21) 

3. Select the desired LUN, and click Release. 

4. Click OK on both confirmation messages. 
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4.11 Setting and Releasing Command Devices 

You can designate up to two command devices, each of which must be 33 MB or greater. 

4.11.1 Setting a Command Devices 
1. On the Array System Viewer window, click the Logical Status tab (see Figure 3.30). 

2. Click the Command Devices icon to display the Command Devices Settings window 
(see Figure 4.24). 

3. Click Set to display the Command Devices Settings window (see Figure 4.25). 

4. In Available Logical Units list, select the desired LUN, and click the  button to 
move that LUN to the Command Devices to Set list (see Figure 4.26). 

5. Click OK on both confirmation messages.  

The Logical Status tab displays the new command device (see Figure 4.27). 

 

Figure 4.24 Setting Command Devices 
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Figure 4.25 Command Devices Settings Window (before setting) 

 

Figure 4.26 Command Devices Settings Window (after setting) 
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Figure 4.27 Command Device Set 
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4.11.2 Modifying a Command Device 
1. Click the Logical Status tab on the Array System Viewer window, and then click the 

Command Devices icon (refer to Figure 4.24). 

2. Select the desired Command Device number, and then click Modify to display the 
Modify Command Devices window (see Figure 4.28). 

3. In the RAID Manager Protect drop-down list, select Disable or Enable, and then click 
OK on both confirmation messages. 

 

Figure 4.28 Modify Command Devices Window 

4.11.3 Releasing a Command Device 
1. Click the Logical Status tab on the Array System Viewer window, and then click the 

Command Devices icon (refer to Figure 4.24). 

2. Select the Command Device number you want to release the command devices, and 
then click Release. 

3. Click OK on both confirmation messages. 
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4.12 Enabling and Disabling the License Key for Optional Products 

4.12.1 Installing Optional Features 

WARNING: Depending on which options are being installed, this operation may require 
stopping I/O from the host and rebooting.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are 
required to reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. 
When restarting the subsystem, you must restart the clusters. 

1. Click the Logical Status tab on the Array System Viewer window (see Figure 3.30), 
and then click the License Key icon (see Figure 4.29). 

2. Click Install to display the Install Options dialog box (see Figure 4.30). 

3. If you are using a key code to install options, do the following: 

– Click the Key Code radio button. 

– Enter the key code(s).  

– Click OK on the confirmation message. 

4. If you are using a key file, do the following: 

– Click the Key File radio button, and then use Browse to specify the path to the 
key file.  

– Click OK, to open the Install Options dialog box (see Figure 4.31). 

– Select or de-select the desired options, then click OK on the confirmation 
message. 

– Click Close to display the Result window (see Figure 4.32). 

5. Depending on which options have been installed, you may need to restart the 
subsystem in order to install the option. If restarting is not necessary, a confirmation 
message will display. Click OK. 

6. If restarting is necessary, the Restart Warning dialog box will display (see Figure 
4.33). Stop host access before continuing. If you are using TrueCopy or TrueCopy 
Extended Distance, change the pair status to PSUS before you reboot. Check OK to 
reboot, and then click OK on the Warning dialog box. 

7. Restarting the subsystem should take between 4 and 15 minutes.  

8. Click OK on the confirmation message. The Array System Viewer window closes, and 
you are returned to the Main window. 
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Figure 4.29 Selecting the License Key View 

 

Figure 4.30 Install Options Dialog Box 

 

Figure 4.31 Install Options Selection Window 
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Figure 4.32 Result Window 

 

Figure 4.33 Restart Warning Dialog Box 
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4.12.2 De-installing the Optional Features 

WARNING: Depending on which options are being de-installed, this operation may 
require stopping I/O from the host and rebooting.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are 
required to reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. 
When restarting the subsystem, you must restart the clusters. 

1. Click the Logical Status tab on the Array System Viewer window (see Figure 3.30), 
and then click the License Key icon (see Figure 4.29). 

2. Click De-install to display the De-install Options dialog box (see Figure 4.34). 

3. Enter the key code and click OK on both confirmation windows. 

4. Depending on which options have been de-installed, you may need to restart the 
subsystem in order to de-install the option. If restarting is not necessary, a 
confirmation message will display. Click OK. 

5. If restarting is necessary, the Restart Warning dialog box will display (see Figure 
4.33). Stop host access before continuing. If you are using TrueCopy or TrueCopy 
Extended Distance, change the pair status to PSUS before you reboot. Check OK to 
reboot, and then click OK on the Warning dialog box. 

6. If you are using TrueCopy or TrueCopy Extended Distance, change the pair status to 
PSUS before you reboot. Click OK to continue. 

7. Restarting the subsystem should take between 4 and 15 minutes. 

8. Click OK on the confirmation message. The Array System Viewer window closes, and 
you are returned to the Main window. 

 

Figure 4.34 De-install Options Dialog Box 
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4.12.3 Enabling or Disabling Optional Features 

WARNING: This operation may require stopping I/O from the host and rebooting. 

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are 
required to reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. 
When restarting the subsystem, you must restart the clusters. 

After releasing the key of the priced optional feature, set enable or disable for this 
feature. 

1. Click the Logical Status tab on the Array System Viewer window (see Figure 3.30), 
and then click the License Key icon (see Figure 4.29). 

2. Select the priced optional features to be either enabled or disabled up, and then 
select the Change. 

3. Click OK on the confirmation window. 

4. A window displays, confirming the priced optional features have been set up. 
Depending on the option, the subsystem needs to be restarted in order to validate 
the setup. If the subsystem supports restarting, a message confirming a restart 
request will be displayed. Click OK to restart. 

5. Depending on which options have been de-installed, you may need to restart the 
subsystem in order to de-install the option. If restarting is not necessary, a 
confirmation message will display. Click OK. 

6. If restarting is necessary, the Restart Warning dialog box will display (see Figure 
4.33). Stop host access before continuing. If you are using TrueCopy or TrueCopy 
Extended Distance, change the pair status to PSUS before you reboot. Check OK to 
reboot, and then click OK on the Warning dialog box. 

7. If you are using TrueCopy or TrueCopy Extended Distance, change the pair status to 
PSUS before you reboot. Click OK to continue. 

8. Restarting the subsystem should take between 4 and 15 minutes.  

9. Click OK on the confirmation message. The Array System Viewer window closes, and 
you are returned to the Main window. 
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Chapter 5 Configuring Storage Navigator 

The Configuration Settings window allows you to tailor your system configuration to 
your individual needs. Which tab views are available is determined by your individual 
setup. 

This chapter discusses the following topics: 

 The Configuration Settings Window descriptions (section 5.1) 

 Setting Boot Options (section 5.2) 

 Setting System Parameters (section 5.3) 

 Setting LAN Connection (section 5.4) 

 Setting Maintenance Port IP Address (section 5.5) 

 Setting LAN Port Number (section 5.6) 

 Setting Port Options (section 5.7) 

 Setting Restore Options (section 5.8) 

 Setting Online Verify Modes (section 5.9) 

 Outputting or Setting Configuration Information Using Text Files (section 5.10) 

 Setting iSCSI Port information (section 5.12) 

 Setting iSNS Server Information (section 5.13) 

 Pinging the Initiator Host (section 5.14) 

 Updating the Microcode (section 5.15) 

 Setting the RTC (section 5.16) 

 Setting the Time Zone and NTP Server (section 5.17) 

 Setting Format Mode (section 5.18) 

 Setting Fibre-Channel Information (section 5.19) 

 Setting SNMP Parameters (section 5.20) 

 Setting Password Protection (section 5.21) 

 Setting Backend Diagnosis (section 5.22) 
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5.1 Configuration Settings Window Descriptions 

5.1.1 Boot Options Tab 

 

Figure 5.1 Configuration Settings Window, Boot Options Tab  

 

– System Startup Attribute: Select the configuration of the subsystem: 

– Single Mode: Single configuration 

– Dual Active Mode: Dual active configuration 

– Delay Planned Shutdown: Specify the time in minutes to delay the execution of 
the planned shutdown when the main switch has turned off. The applicable 
range is from 0 to 60 minutes. 

– Drive Detach Mode: Validates the drive blockade mode. 

– Vendor ID: Enter a vendor name with eight characters. When the name consists 
of less than seven characters, make an eight-character entry by filling the reset 
with space(s). The default value set in HITACHI . (  Denotes a space.) 

– Product ID: Enter a model name with 16 characters. When the name consists of 
less than 16 characters, make a 16-character entry by filling the reset with 
space(s). 

– ROM Microcode Version: Specifies a microcode version of a ROM reported by 
inquiry command. 

– RAM Microcode Version: Specifies a microcode version of a RAM reported by 
inquiry command. 
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5.1.2 System Parameter Tab 

 

Figure 5.2 Configuration Settings Window, System Parameter Tab  

 

– Options: Set the optional function(s) according to the configuration of the 
subsystem: 

– Turbo LU Warning: When the Turbo LU function is invalidated, a warning is 
reported. 

– Write Unique Response Mode: Validates the Write Unique Response Mode. 

– Auto Reconstruction Mode: Validates the Auto Reconstruction Mode. 

– Forced Write Through Mode: Validates the Forced Write Through Mode. 

– LU Ownership Change Disable Mode: Validates the LU Ownership Change 
Disable Mode. 

– ShadowImage I/O Switch Mode: Validates the ShadowImage I/O Switch Mode. 

– Synchronize Cache Execution Mode: Validates the Synchronize Cache 
Execution Mode. 

– Drive Detach Mode: Validates the Drive Detach Mode. 

– Operation if the processor failure occurs: Sets the operation to be performed 
when a processor failure occurs: 

– Reset the fault: Resets a failure and restarts the controller. 

– Shutdown the system: Shuts the subsystem down. 
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– Web Title: If the home page of the subsystem is displayed with the browser, it 
specifies a character string displayed on the title bar of the browser. Enter up to 
32 one-byte coded alphanumeric or characters (except for the ‘ (single quotation 
mark), “ (double quotation mark), and \ (backslash) symbols) other than 
numeric. 

– Write & Verify Execution Mode: Set the write & verify execution mode of the 
controller 0/1: 

– ON: Executes write and verify. 

– OFF: Does not execute write and verify. 
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5.1.3 LAN Tab 

 

Figure 5.3 Configuration Settings Window, LAN Tab  
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5.1.4 Maintenance LAN Tab 

 

Figure 5.4 Configuration Settings Window, Maintenance LAN Tab 
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5.1.5 LAN Port Number Tab 

 

Figure 5.5 LAN Port Number Tab 
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5.1.6 Port Options Tab 

 

Figure 5.6 Configuration Settings Window, Port Options Tab  

 

– Port Options: Sets the port options : 

– Reset/LIP Mode (Signal): The mode to transmit Reset/LIP signals to other 
ports. 

– Reset/LIP Mode (Process): The mode to transmit reset processing to other 
ports. 

– LIP Port ALL Reset Mode: The mode to execute reset on receiving LIP. 

Note: Reset/LIP Mode (signal) is enabled if the Reset/LIP Mode (Process) is set. 
Port Option can be multiply set, but depending on the setting, it may not function 
properly. If it is to be set, please refer to the appended manual of the subsystem and 
set only the applicable parameters. 
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5.1.7 Restore Options Tab 

 

Figure 5.7 Configuration Settings Window, Restore Options Tab  

 

– Drive Restoration Mode: Specify a mode in which drives are to be restored: 

– Background: Executes drive restoration while host I/O processing is not 
executed. 

– Interleave (Normal): Restores the drive at preset time intervals (specified as 
“Interval Time”) giving preference to a host command (restores after 
executing the command). 

– Interleave (Prior): Restores the drive at preset time intervals (specified as 
“Interval Time”) taking preference over a host command. 

– Drive Restoration: Instructs whether to start the following operations 
automatically or manually. The operations concerned are data restoration to the 
failed drive or to the spare drive, copy back of the data from the spare drive to 
the original drive, and dynamic sparing: 

– Manual: Starts restoring data and copying by manual operations. 

– Auto: Automatically starts restoration of data and copying. 

– Interval Time: Specify a time interval of drive restoration. The default interval 
time is 10 × 10 ms and drive restoration is executed at intervals of 100 ms. 
Specify a multiplication factor 0 to 255 in a unit of 10 ms. 
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– Processing Unit Size: Specify the size of the data block to be restored. The 
value of the range of 1 to 511 is specified by the multiple of 128. The minimum 
value is 128, which restores 65-kB data in a single operation. When Interleave 
mode is specified, the function restores data of a processing unit size specified 
here, waits for a time interval specified here, then starts the next data 
restoration. 

– Dynamic Sparing: Specify a mode for data restoration for the spare drive when 
the error occurrence count controlled by preventive maintenance exceeds the 
threshold value: 

– Execute (Read/Write & Online Verify): When the error occurrence count in 
Read/Write Error or Online Verify Error, Threshold Value Over and Start of 
Dynamic Sparing are displayed on the panel and data restoration is 
performed for the spare drive (when the spare drive is not used), and the 
error disk is blocked. 

– Execute (Read/Write): When the error occurrence count in Read/Write 
Error exceeds the threshold value, Threshold Value Over and Start of 
Dynamic Sparing are displayed on the panel and data restoration is 
performed for the spare disk in the spare drive (when the spare disk is not 
used), and the error disk is blocked. 
When the error occurrence count in Online Verify Error exceeds the 
threshold value, Threshold Value Over is displayed on the panel but Dynamic 
Sparing is not performed. 

– Do not Execute: When the error occurrence count in Read/Write Error or 
Online Verify Error exceeds the threshold value, Threshold Value Over is 
displayed on the panel but Dynamic Sparing is not performed. 

– Spare Drive Operation Mode: Specify the spare drive operation mode: 

– Variable: When a failed drive is replaced, the new drive becomes a spare 
drive. 

• Applying No Copy Back Mode on All the Units: Specify whether or not 
to apply copy back mode. 

– Fixed: The drive that has been set in section 4.9.1 becomes a fixed spare 
drive (a former way). 
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5.1.8 Online Verify Tab 

 

Figure 5.8 Configuration Settings Window, Online Verify Tab 
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5.1.9 Constitute Tab 

 

Figure 5.9 Configuration Settings Window, Constitute Tab  
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5.1.10 iSCSI Tab 

 

Figure 5.10 Configuration Settings Window, iSCSI Tab  
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5.1.11 iSNS Tab 

 

Figure 5.11 Configuration Settings Window, iSNS Tab 

 

– iSNS Server: 

– Use: Specify whether to use the iSNS server or not. When use the iSNS server, 
specify the IP Address and Port Number of the iSNS server. 
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5.1.12 Ping Tab 

 

Figure 5.12 Configuration Settings Window, Ping Tab 

 

– Port: Select the port to be sending ping. 

– Destination IP Address: Specify the IP address of the initiator. 
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5.1.13 Micro Update Tab 

 

Figure 5.13 Configuration Settings Window, Micro Update Tab  
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5.1.14 RTC Tab 

 

Figure 5.14 Configuration Settings Window, RTC Tab 

 

– Setting: Select Manual or Auto: 

– Manual: Set the date and time. 

– Auto: Set the time of the Storage Navigator computer. 

– Date: Displays the date. 

– Time: Displays the time. 
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5.1.15 Time Zone Tab 

 

Figure 5.15 Configuration Settings Window, Time Zone Tab 

 

– Time Zone: Select a time zone from the Time Zone drop-down list. 

Automatically adjust clock for daylight saving changes: Specify whether to use 
the daylight saving or not. 

– NTP Server: Specify the IP address of the NTP server. 
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5.1.16 Format Mode Tab 

 

Figure 5.16 Configuration Settings Window, Format Mode Tab 

 

– Format Priority Mode: Specify a format priority mode: 

– Normal: Formats at an idle time when no host I/O is executed. 

– Host: Host's I/O is executed preferentially. 

– Format: Subsystem formats are done preferentially. 

– Format Data: Specify a data format. 
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5.1.17 SNMP Tab 

 

Figure 5.17 Configuration Settings Window, SNMP Tab 

For more information on configuring SNMP settings, see Hitachi TagmaStore Adaptable 
Modular Storage SNMP Agent User’s Guide (MK-95DF705). 
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5.1.18 Password Protection Tab 

 

Figure 5.18 Configuration Settings Window, Password Protection Tab 
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5.1.19 Backend Diagnosis Tab 

 

Figure 5.19 Configuration Settings Window, Backend Diagnosis Tab 
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5.2 Setting Boot Options 

WARNING: This operation will require stopping I/O from the host and rebooting. 

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are 
required to reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. 
When restarting the subsystem, you must restart the clusters. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar.  

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Boot Options tab (see Figure 5.20). For a detailed description of the Boot 
Options tab, refer to section 5.1.1. 

4. Select the system startup attribute: 

Single Mode: Single configuration 

Dual Active Mode: Dual active configuration 

5. You can specify an amount of time to delay a shutdown after the main switch is 
turned off. You can specify from 0 to 60 minutes. 

6. Specify the drive detach mode as either enabled or disabled. 

7. Specify the vendor name, using up to eight characters. If you use less than eight 
characters, enter spaces after the characters to total eight. 

8. Specify the model name, using up to sixteen characters. If you use less than sixteen 
characters, enter spaces after the characters to total sixteen. 

9. Specify the ROM microcode version that will be reported in response to an inquiry 
command. 

10. Specify the RAM microcode version that will be reported in response to an inquiry 
command. 

11. Click Apply after you have completed the settings, and then click OK on the 
confirmation message. 

12. If restarting is necessary, the Restart Warning dialog box will display (see Figure 
5.21). Stop host access before continuing. If you are using TrueCopy or TrueCopy 
Extended Distance, change the pair status to PSUS before you reboot. Check OK to 
reboot, and then click OK on the Warning dialog box. 

13. Rebooting should take between 4 and 15 minutes. 

14. Once the reboot is successfully completed, click OK on the confirmation message. 
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Figure 5.20 Setting Boot Options 

 

Figure 5.21 Restart  Warning Dialog Box 
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5.3 Setting System Parameters 

This operation does not require a reboot. 

1. Access the Array System Viewer window by selecting a storage array in the list view 
box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the System Parameter tab (see Figure 5.22). For a detailed description of the 
System Parameter tab, refer to section 5.1.2. 

4. Click the Turbo LU Warning checkbox if you want a warning if the Turbo LU function 
is invalidated. 

5. Click the Write Unique Response Mode checkbox if you want to implement this 
mode. 

6. Click the Auto Reconstruction Mode checkbox if you want to implement this mode. 

7. Click the Forced Write Through Mode checkbox if you want to implement this 
mode. 

8. Click the LU Ownership Change Disable Mode checkbox if you want to implement 
this mode. 

9. Click the ShadowImage I/O Switch Mode checkbox if you want to implement this 
mode. 

10. Click the Synchronize Cache Execution Mode checkbox if you want to implement 
this mode. 

11. Click the Drive Detach Mode checkbox if you want to implement this mode. 

12. In the Operation if the processor failure occurs checkbox, select one of the 
following: 

Reset the fault: Resets a processor failure and restarts the controller. 

Shutdown the system: Shuts the subsystem down when a processor failure occurs. 

13. In the Web Title text box, you can specify the character string that displays on the 
browser title bar when you access the subsystem home page. You can enter up to 32 
alphanumeric characters. You may not use the ‘ (single quotation mark), “ (double 
quotation mark), or \ (backslash) symbol).  

14. For each controller, set the Write & Verify Execution Mode either to On or Off.  

15. Click Apply, and then click OK on the confirmation messages. 
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Figure 5.22 Setting System Parameters 
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5.4 Setting LAN Configuration 

5.4.1 Setting Without Rebooting 

To set the LAN configuration of the subsystem without rebooting: 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, click Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the LAN tab (see Figure 5.23). For a detailed description of the LAN tab, refer 
to section 5.1.3. 

4. Click Set now without reboot. 

5. In the Maintenance Port IP Address Automatic Change Mode field, select either 
Enable or Disable. 

Note: If you click Enable, you cannot use the Maintenance LAN tab to set the 
maintenance port. 

6. The new settings are displayed in the LAN boxes. 

7. Click Apply, and then click OK on both confirmation messages.  

8. If the subsystem cannot be connected, the Confirm LAN Environment warning 
message displays (see Figure 5.24). If this displays, change the connection IP 
address. 
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Figure 5.23 Setting LAN Configuration without Rebooting 

 

Figure 5.24 Confirm LAN Environment Warning Message 
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5.4.2 Setting with a Reboot 

WARNING: This operation will require stopping I/O from the host and rebooting.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are 
required to reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. 
When restarting the subsystem, you must restart the clusters. 

To set the LAN configuration of the subsystem with a reboot: 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar.  

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, click Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the LAN tab (see Figure 5.25). For a detailed description of the LAN tab, refer 
to section 5.1.3.  

4. Click Set with reboot. 

5. For each controller, do the following: 

– Specify whether or not the maintenance port IP address will be set 
automatically. 

– Specify whether to enable DHCP mode by using the checkbox.  

– Specify the IP address, subnet mask, default gateway, and negotiation by 
entering the information into the text boxes. You cannot change the Ether 
Address field.  

Note: If you enabled DHCP, then these fields are not available.  

6. Click Apply. 

7. If restarting is necessary, the Restart Warning dialog box will display (see Figure 
5.21). Stop host access before continuing. If you are using TrueCopy or TrueCopy 
Extended Distance, change the pair status to PSUS before you reboot. Check OK to 
reboot, and then click OK on the Warning dialog box. 

8. Rebooting should take between 4 and 15 minutes. 

Note: To validate the LAN information, restart the array unit. The previous settings 
stay valid until restarting. The array unit cannot access the host until the reboot is 
completed and the system restarts. Therefore, be certain the host has stopped 
accessing data before beginning the restart process. 

Note: If the LAN configuration information is modified, an error message (Interface 
Error) may be displayed without displaying a restart completion message when 
restarting is initiated. When an error message is displayed after the LAN 
configuration information is modified and a restarting is directed to be done, close 
the Unit window, make a change in the information that has been registered through 
the Main window, and then open the Unit window again. 
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9. Reboot should take between 4 and 15 minutes. Once it is completed, click OK on the 
confirmation message.  

 

Figure 5.25 Setting LAN Configuration with a Reboot 
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5.5 Setting Maintenance Port IP Address 

Note: The Maintenance Port IP address is set at the factory, so under ordinary 
circumstances it should not be necessary to change it. This action does not require a 
reboot. 

To set the maintenance port IP address: 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar.  

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Maintenance LAN tab (see Figure 5.25). For a detailed description of the 
Maintenance LAN tab, refer to section 5.1.4.  

4. In the Setting text box, input the Maintenance Port IP address.  

Note: If you previously selected Enable in the Maintenance Port IP Address 
Automatic Change Mode field on the LAN tab, you cannot make settings on this tab. 

5. Click Apply, and then click OK on the confirmation messages. 

 

Figure 5.26 Setting Maintenance Port IP Address 
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5.6 Setting LAN Port Number 

The port number can be set when the microcode version of the AMS500/AMS200/WMS100 
array subsystem is 0726/E or later (9500V/9520V array subsystem is x65B/H or later) and 
the version of Navigator is 2.61 or later. The port number is set for each controller, but 
set both controllers without closing the setting window. After setting the both 
controllers, close the Unit screen and edit the services file of the OS that is operating 
Navigator. When the two or more disk array subsystems are registered, set all of them. 
The setting of the services file is enabled without closing the Main window. 

Set the port number in a range of 1024 to 49151. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the LAN Port Number tab (see Figure 5.27). 

4. In the Port Number dialog box, select Controller 0 and enter an unused port number 
in the text box. 

5. Click Apply, and click OK on the Confirmation the Port Number dialogue box.  

6. On the Set Same Port Number dialogue box (see Figure 5.29), click Cancel. 

7. Select Controller 1 and enter the same port number in the text box. 

8. The Set Same Port Number dialogue box displays again. Click OK. 

9. Click OK on the Add to Services File dialogue box (see Figure 5.30). 

10. Open a text editor and add the port number to the services file. A sample using 
Windows® 2000 is shown at Figure 5.31. When you add the port number to the last 
line, be sure to start a new line. 
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Figure 5.27 Setting LAN Port Number 

 

Figure 5.28 Confirming Port Number 

 

Figure 5.29 Set Same Port Number 
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Figure 5.30 Add to Services File 

# Copyright (c) 1993-1999 Microsoft Corp. 
# 
# This file contains port numbers for well-known services defined by IANA 
# 
# Format: 
# 
# <service name>  <port number>/<protocol>  [aliases...]   [#<comment>] 
# 
 
echo                7/tcp 
echo                7/udp 
 : 
 : 
radacct          1813/udp                           #RADIUS accounting protocol 
nfsd             2049/udp    nfs                    #NFS server 
knetd            2053/tcp                           #Kerberos de-multiplexor 
man              9535/tcp                           #Remote Man Server 
df-damp-snm      23456/tcp 
 

Figure 5.31 Adding Port Number to Services File (Windows® 2000) 
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5.7 Setting Port Options 

WARNING: This operation will require stopping I/O from the host.  

This setting becomes effective without a reboot. 

To set the maintenance port IP address: 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Port Options tab (see Figure 5.25). For a detailed description of the Port 
Options tab, refer to section 5.1.4. 

4. Select a port, and then set the following options: 

– Reset/LIP Mode (Signal) sets the mode to transmit Reset/LIP signals to other 
ports. This is only enabled if you set the Reset/LIP Mode (Process) (below). 

– Reset/LIP Mode (Process) sets the mode to transmit reset processing to other 
ports. 

– LIP Port ALL Reset Mode sets the mode to execute reset on receiving LIP. 

5. You can set options on multiple ports, but be sure that you comply with the 
parameters that are in the applicable User and Reference Manual. 

6. Click Apply, and then click OK on the confirmation message. 

7. The Stop I/O warning message displays (see Figure 5.33), because host access will be 
disrupted during the port setting. Stop I/O from the host before continuing. 

8. Once it is completed, click OK on the confirmation message. 
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Figure 5.32 Setting Port Options 

 

Figure 5.33 Stop I/O Warning Message 
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5.8 Setting Restore Options 

Caution: Do not undertake this operation during a drive restoration, or the settings will 
not be effective.  

This operation does not require a reboot. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Restore Options tab (see Figure 5.25). For a detailed description of the 
Restore Options tab, refer to section 5.1.4. 

4. In the Online Restoration Mode dialog box, select one of the following: 

– Background restores the drive while host I/O processing is not being executed. 

– Interleave (Normal) restores the drive at preset time intervals (specified as 
“Interval Time”) giving preference to a host command (restores after executing 
the command). 

– Interleave (Prior) restores the drive at preset time intervals (specified as 
“Interval Time”) taking preference over a host command. 

5. In the Drive Restoration box, select whether drive restoration is set manually or 
automatically.  

6. In the Interval Time box, specify a time interval for drive restoration. The default 
interval time is 10 (which is automatically multiplied by 10 ms), which makes the 
interval 100 ms. You can specify from 0 to 255, which will be automatically 
multiplied by 10 ms. 

7. In the Processing Unit Size box, specify the size of the data block to be restored. 
You can specify a range from 1 to 511, which is automatically multiplied by 128. The 
minimum value of 1 (multiplied by 128) restores 65-kB data in a single operation. 
When Interleave mode is specified, the function restores data of a processing unit 
size specified here, waits for a time interval specified here, then starts the next 
data restoration. 

8. In the Dynamic Sparing box, specify a mode for data restoration for the spare drive 
when the error occurrence count controlled by preventive maintenance exceeds the 
threshold value. 

– Execute (Read/Write & Online Verify): When the error occurrence count in 
Read/Write Error or Online Verify Error, Threshold Value Over and Start of 
Dynamic Sparing are displayed on the window and data restoration is performed 
for the spare drive (when the spare drive is not used), and the error disk is 
blocked. 
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– Execute (Read/Write): When the error occurrence count in Read/Write Error 
exceeds the threshold value, Threshold Value Over and Start of Dynamic 
Sparing are displayed on the window and data restoration is performed for the 
spare disk in the spare drive (when the spare disk is not used), and the error disk 
is blocked. 
When the error occurrence count in Online Verify Error exceeds the threshold 
value, Threshold Value Over is displayed on the panel but Dynamic Sparing is 
not performed. 

– Do not Execute: When the error occurrence count in Read/Write Error or 
Online Verify Error exceeds the threshold value, Threshold Value Over is 
displayed on the window but Dynamic Sparing is not performed. 

9. In the Spare Drive Operation Mode box, select one of the following: 

– Variable: When a failed drive is replaced, the new drive becomes a spare drive. 

– Applying No Copy Back Mode on All the Units: Specify whether to apply the 
copy back mode. 

– Fixed: The drive that has been previously set becomes a fixed spare drive. 

10. Click Apply, and then click OK on the confirmation messages. 

 

Figure 5.34 Setting the Drive Restore Option  
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5.9 Setting Online Verify Mode 

This operation does not require a reboot. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Online Verify tab (see Figure 5.35). For a detailed description of the 
Online Verify tab, refer to section 5.1.8. 

4. Make the following settings: 

– Online Verify Test: Specify whether or not to execute an online verify test. 

– Skip Verify: Specify whether or not to ignore an online verify request. 

5. Click Apply, and then click OK on the confirmation messages. 

 

Figure 5.35 Setting Online Verify Mode 
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5.10 Outputting or Setting Configuration Information with Text Files (Constitute Tab) 

5.10.1 Overview 

You can use text files to either output or set the subsystem configuration information. 
You can output the following types of information with text files Information you can 
output with text files includes the status of the subsystem, RAID groups, LUs, ports, host 
groups, and subsystem components. Information that can be set with text files includes 
system parameters, RAID groups, LUs, ports and host groups. You cannot set the 
configuration of subsystem components using a text file.  

Separate text files are required. You can copy configuration information between 
subsystems by outputting a text file from the first system, and then using that text file 
to set the configuration of the second system.  

Copying configuration information between subsystems can be executed by outputting a 
text file of the configuration from the subsystem, then using the output text file to set 
another subsystem. It is possible to edit a text file and then use that file to set the 
configuration, but as a general rule you should only do it for the same subsystem.  

5.10.2 Outputting Information to a Text File 

Caution: Before outputting configuration files, make sure that all optional features are 
locked.  

To output configuration information to a text file: 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, click Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Constitute tab (see Figure 5.36). For a detailed description of the 
Constitute tab, refer to section. 5.1.9. 

4. In the Operation dialog box, click Output. 

5. In the Select Configuration Information box, select one of the following types of 
information to output: 

– RAID Group/Logical Unit 

– System Parameters 

– Port Information 

– Boot Options 

– Parts Information (not available when Input is selected) 

– NAS System LU/User LU 

– CHAP User (not available when Output is selected) 
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6. In the File box, either type in the file path or click Browse to specify the output 
destination file. 

7. Click Apply, and then click OK on the confirmation message.  

8. If you output system parameters, the file will resemble Figure 5.37. 

9. If you output RAID Group/Logical Unit parameters, the file will resemble Figure 5.38. 

10. If you output Host Group information, the file will resemble Figure 5.39. 

11. If you output LAN information, the file will resemble Figure 5.43. 

 

Figure 5.36 Outputting Configuration Information to a Text File  

  

Figure 5.37 System Parameter Output File Format  
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Figure 5.38 RAID Group/Logical Unit Configuration Output File 
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Figure 5.39 Host Group Information Output File 

 

Figure 5.40 Boot Options Information Output File 
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Figure 5.41 NAS System/User LUs Information Output File 
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Figure 5.42 iSCSI Port Information Output File 
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Figure 5.43 LAN Information Output File 

 

5.10.3 Setting RAID/LU Configuration using a Text File 

WARNING: During this operation the subsystem cannot execute commands from the host, 
and cannot be operated with Storage Navigator. System parameters and failure 
monitoring will continue.  

WARNING: If you are setting RAID group/logical unit configuration, all user data and the 
previous configuration will be deleted. Be sure to back up your data before continuing. 

Caution: If you have a dual system, make sure that both controllers are attached and 
working normally.  

1. The RAID Group/Logical Unit file has three parameters: 

– RAID configuration information: Specifies RAID level, RAID group number and 
RAID size. If the RAID group is not set, “-” is shown after Level, and no other 
parameters are set. 

– LU configuration information: Specifies logical unit number, logical unit 
capacity, pre-read capacity, number of controllers in current use, number of 
controllers in default use, RAID group number and RAID level, and logical unit 
status. 

Specify the logical unit status as normal. 

If you are allocating the full capacity of the RAID group to one logical unit, 
specify “All” in Capacity. 

The controller number will become the same as the controller that is in 
default use, regardless of what is specified. 

If you are specifying logical units of less than the maximum logical unit 
number, specify at the end that “After nn, not define” (nn: the last logical 
unit number + 1). 

– Drive information: Sets the configuration of the HDU installed in the subsystem. 
If no HDU is installed, specify “Nothing”. If you specify a capacity larger than the 
installed HDU, it is regarded as an error and not set. 
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2. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

3. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

4. Click the Constitute tab (refer to Figure 5.36). For a detailed description of the 
Constitute tab, refer to section. 5.1.9. 

5. In the Operation box, select Input. 

6. In the Select Configuration Information box, click RAID Group/Logical Unit. 

7. In the File box, either type in the file path or click Browse to specify the input 
destination file. 

8. Click Apply, and then click OK on the confirmation message. 

9. A warning message displays, stating that the current RAID/LU configuration will be 
deleted Figure 5.44. You should already have backed up your configuration 
information. Click OK to continue, or click Cancel to cancel. 

10. A warning message displays, stating that user data in the affected logical units will 
be invalidated (see Figure 5.45). You should already have backed up your user 
information. Click OK to continue, or click Cancel to cancel. 

11. Several status messages will display, noting the progress of the configuration setting. 
Once the process is complete, click OK on the confirmation message. 

 

Figure 5.44 RAID/LU Configuration Data Deletion Warning Message 
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Figure 5.45 User Data Deletion Warning Message 
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5.10.4 Setting Port or Host Group Configuration with a File 

WARNING: This operation will require stopping I/O from the host.  

Caution: If you have a dual system, make sure that both controllers are attached and 
working normally. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Constitute tab (refer to Figure 5.36). For a detailed description of the 
Constitute tab, refer to section. 5.1.9. 

4. In the Operation box, click Input.  

5. In the Select Configuration Information box, click Port Information (Update). 

6. In the Setting Information for Input box, select one or more of the following: 

– Port Options 

– Host Group Options 

– Mapping Information 

– WWN Information (available when the LUN Manager is enabled). Select the items 
that you will set from Input. 

7. In the File box, either type in the file path or click Browse to specify the output 
destination file. 

8. Click Apply. If you are setting ports or host groups, Figure 5.46 displays. Stop host 
access to the subsystem or host group, and then click OK to continue. 

9. Once operations are complete, click OK on the confirmation messages. 

 

Figure 5.46  Stop Host Access Warning Message (Port or Host Group Operations) 
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5.10.5 Setting CHAP User Information with a File 

Caution: If you have a dual system, make sure that both controllers are attached and 
working normally. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar.  

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Constitute tab (see Figure 5.36). For a detailed description of the 
Constitute tab, refer to section. 5.1.9. 

4. In the Operation box, click Input.  

5. In the Select Configuration Information box, click CHAP User. 

6. Click Browse, specify the input directory and file name, and then click Apply. 

7. Click OK on the confirmation message.  

Table 5.1 lists the format of the CHAP User information setting file. 

Table 5.1 CHAP User Information Format 

File Contents Descriptions 

User name,secret,Target No. or alias ... The lines are invalid until <CHAP User> appears. 

<CHAP User>,, The valid lines are from <CHAP User> to <END>. 

<Port 0A>,, The line specifies the port. (<Port ALL> specifies all ports) 

hitachi-0,abcdefghij00,alias0 The first column is CHAP User, and the second column is Secret. 

hitachi-1,abcdefghij01,alias1 The third row and the following are aliases of Target to assign. 

#hitachi-1,abcdefghij01,alias1 The line with the first character of # is a comment line. (Invalid line) 

hitachi-2,abcdefghij02,3 The Target number can be specified as the alias of Target. 

<Port 0B>,,  

<Add CHAP User>,, If <Add CHAP User> is specified, CHAP User is added. 

hitachi-0,abcdefghij00,alias0 If nothing is specified, all CHAP Users are deleted, and then added. 

hitachi-1,abcdefghij01,alias0,alias01,alias02 One or more Targets can be specified. 

<Port 1A>,,  

<Port 1B>,,  

<END>,, The line of <END> and the following are all invalid lines. 

 



 
 
 

 Hitachi TagmaStore AMS/WMS Storage Navigator GUI User’s Guide      151 

5.10.6 Setting Boot Option Information with a File 

WARNING: This operation will require stopping I/O from the host and rebooting.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance, change the pair 
status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. 
When restarting the subsystem, you must restart the clusters. 

Caution: If you have a dual system, make sure that both controllers are attached and 
operating normally. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Constitute tab (see Figure 5.36). For a detailed description of the 
Constitute tab, refer to section. 5.1.9. 

4. In the Operation box, select Input.  

5. In the Select Configuration Information box, click Boot Option. 

6. In the File box, either type in the file path or click Browse to specify the input 
destination file. 

7. Click Apply, and then click OK on the confirmation message.  

8. If restarting is necessary, the Restart Warning dialog box will display (see Figure 
5.21). Stop host access before continuing. If you are using TrueCopy or TrueCopy 
Extended Distance, change the pair status to PSUS before you reboot. Check OK to 
reboot, and then click OK on the Warning dialog box. 

9. Rebooting should take between 4 and 15 minutes to complete. You will see several 
progress messages. Once the restart is complete, click OK on the confirmation 
message. 
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5.11 Setting NAS System LU or User LU Information with a File 

WARNING: This operation will delete the current system and user LUs. You should back 
up your existing configuration if you want to retain the information.  

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Constitute tab (see Figure 5.36). For a detailed description of the 
Constitute tab, refer to section. 5.1.9. 

4. In the Operation box, click Input. 

5. In the Select Configuration Information box, click NAS: System LU/User LU. 

6. In the File box, either type in the file path or click Browse to specify the input 
destination file. 

7. Click Apply, and then click OK on the confirmation message. 

8. The System and User LU Deletion warning message displays, warning you that your 
current system and user LU information will be deleted. If you want to retain the 
information, back up your configuration. Click OK to continue. 

9. Once the process is complete, click OK on the confirmation message. 

 

Figure 5.47 System and User LU Deletion Warning Message 
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5.11.1 Setting LAN Information with a File 

Caution: If you have a dual system, make sure that both controllers are attached and 
working normally. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Constitute tab (refer to Figure 5.36). For a detailed description of the 
Constitute tab, refer to section. 5.1.9. 

4. In the Select Configuration Information box, click LAN Information. 

5. In the Operation box, click Input. Make the following settings, if desired:  

– Maintenance Port IP Address Automatic Change Mode  

– IP Address 

– Subnet Mask 

– Default Gateway 

– Maintenance LAN Parameter (Network Address) 

6. In the File box, either type in the file path or click Browse to specify the output 
destination file. 

7. Click Apply, and then click OK on the confirmation message. 
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5.12 Setting iSCSI Port Information 

WARNING: This operation will require stopping I/O from the host. 

To set the iSCSI port information: 

1. Open the Configuration Settings window by one of the following methods: 

– On the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

2. Click the iSCSI tab (see Figure 5.48). For a detailed description of the iSCSI tab, 
refer to section 5.1.10. 

3. Select a port, then in the Network box, set the following parameters: 

– IP address 

– Subnet mask 

– Default Gateway 

– Port number 

– Keep Alive Timer (sec) 

– The MTU, Ether Address, and Result text boxes are not available. 

4. Click Apply, and then click OK on the confirmation message. 

5. The Stop Host Access warning message displays (see Figure 5.49). Stop host I/O 
access, and then click OK to continue.  

6. Once the process is complete, click OK on the confirmation message.  
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Figure 5.48 Setting iSCSI Port Information 

 

Figure 5.49 Stop Host Access Warning Message 
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5.13 Setting iSNS Server Information 

To set the iSNS server information: 

1. Access the Array System Viewer window by selecting a storage array in the List View 
box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the iSNS tab (see Figure 5.50). For a detailed description of the iSNS tab, refer 
to section 5.1.11. 

4. Select a port. In the iSNS Server box, enter the IP address and port number. 

5. Click Apply, and then click OK on the confirmation message. 

6. Once the process is complete, click OK on the confirmation message. 

 

Figure 5.50 Setting iSNS Server Information 
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5.14 Pinging the Initiator Host 

This operation pings the initiator (host) and displays the result. 

1. Open the Configuration Settings window by one of the following methods: 

– On the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. 

2. Click the Ping tab (see Figure 5.51). For a detailed description of the Ping tab, refer 
to section 5.1.12. 

3. In the Port box, select the port that you want to ping. 

4. In the Destination IP Address box, type in the IP address. 

5. Click Start. The Host Access Delay warning message displays (see Figure 5.52). Click 
OK, and then click OK on the confirmation message. 

6. Click Refresh to display the results of the ping. 

 

Figure 5.51 Pinging Initiator Host 
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Figure 5.52 Host Access Delay Warning Message 

 

Figure 5.53 Select Refresh Message 

 

Figure 5.54 Ping Results 
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5.15 Updating the Microcode 

The function downloads and replaces the microcode in the subsystem. When replacing 
the microcode, first download it, and then replace it. 

Caution: If the microcode is read during a download, errors will occur during the 
download processing. 

5.15.1 Downloading Microcode 

WARNING: This operation will interrupt I/O from the host and may require rebooting the 
subsystem. 

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are 
required to reboot, change the pair status to PSUS before you reboot. 

WARNING: If you do a hot replacement of the controller board before restarting the 
subsystem or replacing the microcode, the new controller may be blocked.  

Caution: You should not download the microcode when the host has a high I/O load, or 
the download may terminate with a DMES05EA03 error message. If this occurs, retry the 
operation.  

To download microcode: 

1. If you are using Solaris™, IRIX®, HP-UX, or Red Hat® Linux® you will need to copy the 
microcode to the hard disk using a different directory. If you are using Windows, 
microcode is accessed from the CD-R and is not copied. 

Note: For a directory where the Navigator is installed, do not copy the microcode 
directly to the CD-R. Create a sub-directory and copy it under this sub-directory. 
Specify the name of a directory in the hard disk drive to which the microcode is 
copied, with a one-byte coded alphanumeric. 

2. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

3. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

4. Click the Micro Update tab (see Figure 5.55). For a detailed description of the Micro 
Update tab, refer to section 5.1.13. 

5. Click Read. If a revision is displayed in the Revision (Read) box, the microcode has 
already been read.  

Note: If you specify the microcode installed directory, all the microcodes are read 
automatically. 

6. Click OK on the confirmation message to start the download. 
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7. If that version of the microcode has already been downloaded, a confirmation 
message displays asking if you want to overwrite the microcode (see Figure 5.56). 
Click OK to overwrite, and then click OK on the second confirmation message (see 
Figure 5.57). 

8. On the Specify Path window (see Figure 5.58), specify the download directory by 
either entering the path or browsing to select the path, and then click OK. A sample 
path is shown in Figure 5.59. 

9. Click OK on the confirmation message to continue. When the microcode is read, click 
OK on the confirmation message, and the version will display in the Revision (Read) 
field (see Figure 5.60). 

10. Click the Download, and then click OK on the confirmation message. 

11. On the Host Access message (see Figure 5.61), do one of the following: 

– Click Yes if you want the Storage Navigator to not be accessed by the host until 
after you click OK on the confirmation message when the microcode is replaced.  

– Click No if you want the Storage Navigator to be accessed by the host 
immediately after the microcode is replaced, and before you click OK on the 
confirmation message. 

12. You will see several progress messages. You can abort the download by selecting 
Cancel on the Microcode Download window (see Figure 5.62).The download can be 
aborted. To abort the download halfway, click Cancel. A confirmation message is 
displayed. When OK is clicked, the download is aborted. When Cancel is clicked, the 
download is continued. 

13. Once the process is complete, click OK on the confirmation message. 

14. After the microcode is downloaded, you must either restart the subsystem or replace 
the microcode (see section 5.15.2). 

15. If restarting is necessary, the Restart Warning dialog box will display (see Figure 
5.21). Stop host access before continuing. If you are using TrueCopy or TrueCopy 
Extended Distance, change the pair status to PSUS before you reboot. Check OK to 
reboot, and then click OK on the Warning dialog box. 
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Figure 5.55 Downloading Microcode 

 

Figure 5.56 Overwrite Microcode Confirmation Message (1) 

 

Figure 5.57 Overwrite Microcode Confirmation Message (2) 
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Figure 5.58 Specify Path Window 

When using Windows®: 

D:/DF700/program/micro_upload/microprogram/0710A 

When using Solaris™, IRIX®, HP-UX®, or Red Hat Linux®: 

 /home/usr/DF700/program/micro_upload/microprogram/0710A

Directory in the hard disk in which the 
micro program is copied. 

 

Figure 5.59 Sample Path  

 

Figure 5.60 Revision Read  
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Figure 5.61 Host Access Message 

 

Figure 5.62 Microcode Download Window 
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5.15.2 Replacing the Microcode 

WARNING: This operation will interrupt I/O from the host and may require rebooting the 
subsystem. 

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are 
required to reboot, change the pair status to PSUS before you reboot. 

Important: You will need to replace the microcodes on both controllers, in the following 
order: 

– If you are connected either to both controllers or only to controller 0, first 
replace controller 0, then replace controller 1. 

– If you are connected only to controller 1, first replace controller 1, then replace 
controller 0. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Micro Update tab (see Figure 5.63). For a detailed description of the Micro 
Update tab, refer to section 5.1.13. 

4. Select the appropriate controller, click Replace button, and then click OK on the 
confirmation message (see Figure 5.64).  

5. If restarting is necessary, the Restart Warning dialog box will display (refer to Figure 
4.33). Stop host access before continuing. If you are using TrueCopy or TrueCopy 
Extended Distance, change the pair status to PSUS before you reboot. Check OK to 
reboot, and then click OK on the Warning dialog box. 

6. The update should take up to 15 minutes. If you elected to have host access delayed 
during the microcode download (refer to section 5.15.1), clicking OK on the Host 
Access Accepted message will restore host access (see Figure 5.65). Otherwise, 
clicking OK will have no effect because host access will already be started. 

7. Click OK on the confirmation message when the update is completed. 

8. Repeat the above steps with the other controller. 

Note: If you replace the microcode on only one of the controllers, the subsystem is 
placed in a warning status. Replacing the second controller will terminate the 
warning status.  

Note: If you only replace the microcode on only one controller and the Array System 
Viewer window is closed, it is possible that the Array System Viewer window will 
stop opening. If this occurs, register a controller that is not having the microcode 
replaced, then replace the microcode on the second controller. 
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Figure 5.63 Replacing Microcode  

 

Figure 5.64 Replace Microcode Confirmation Message 

 

Figure 5.65 Host Access Accepted Message 
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5.16 Setting the RTC 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Selecting File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Select the RTC tab (see Figure 5.66). For a detailed description of the RTC tab, refer 
to section 5.1.14. 

4. In the Setting box, select one of the following: 

– Click Manual if you want to manually update the settings. 

– Click Auto if you want the settings updated automatically to those on the 
Storage Navigator computer. 

5. If you clicked Manual, enter the date and time. 

6. Click Apply, and then click OK on the confirmation message. 

 

Figure 5.66 Setting RTC  
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5.17 Setting the Time Zone and NTP Server 

To set the time zone: 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. Click the Time Zone 
tab (see Figure 5.67). For a detailed description of the Time Zone tab, refer to 
section 5.1.15. 

3. In the Time Zone box, do the following: 

– Select a time zone from the Time Zone drop-down list. 

– Click the checkbox if you want to automatically adjust the clock for daylight 
saving changes. 

4. In the NTP Server box, specify the IP address of the NTP server. 

5. Click Apply, and then click OK on the confirmation message. 

 

Figure 5.67 Setting Time Zone 
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5.18 Setting Formatting Mode 

WARNING: This operation could affect I/O from the host. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings.  

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Format Mode tab (see Figure 5.68). For a detailed description of the 
Format Mode tab, refer to section 5.1.16. 

4. In the Format Priority Mode box, select one of the following: 

– Normal: Formats at an idle time when no host I/O is executed. 

– Host: Host's I/O is executed preferentially. 

– Format: Subsystem formats are done preferentially. 

5. In the Format Data box, select one of the following: 

– Default 

– 0 

6. After the setting is complete, click Apply. 

7. A message displays stating that the setting is complete. Click OK. 

Note: It may take time to complete the setting. Click Refresh to verify that the 
correct settings have been made. 
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Figure 5.68 Setting Formatting Mode  
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5.19 Setting Fibre Channel Information 

WARNING: This operation requires stopping I/O from the host. 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Fibre Channel tab (see Figure 5.69). For a detailed description of the Fibre 
Channel tab, refer to section 5.1.16. 

4. In the Port Address box, type in the new setting for the port address. Enter 8 bytes 
of data hexadecimal (with 16 characters). 

5. In the Transfer Rate box, select the value from the drop-down menu. 

6. In the Topology Information box, select the value from the drop-down menu. 

7. Click Apply, and then click OK on the confirmation message. 

8. The Host Access warning message displays (see Figure 5.70). Make sure that host 
access to the port has been stopped, and then click OK. 

Note: It may take time to complete the setting. Click Refresh to verify that the 
correct settings have been made. 
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Figure 5.69 Setting Fibre Channel Information  

 

Figure 5.70 Host Access Warning Message 
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5.20 SNMP 

For more information on configuring SNMP settings, see Hitachi TagmaStore AMS and 
WMS SNMP Agent User’s Guide (MK-95DF705). 

5.21 Password Protection 

For more information on password protection, see Hitachi TagmaStore AMS and WMS 
Password Protection User’s Guide (MK-95DF704). 
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5.22 Setting Backend Diagnosis Information 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Open the Configuration Settings window by one of the following methods: 

– From the Tools menu, select Configuration Settings. 

– Click the Configuration Settings icon ( ) in the tool bar. 

3. Click the Backend Diagnosis tab (see Figure 5.71). 

4. In the Auto Diagnosis Threshold box, specify the value in a range of 1 to 255. 

5. Click Apply, and then click OK on the confirmation message. 

 

Figure 5.71 Setting Backend Diagnosis Information 
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 Hitachi TagmaStore AMS/WMS Storage Navigator GUI User’s Guide      175 

Chapter 6 RAID Group Operations 

This chapter discusses the following topics: 

 Displaying RAID group and LU properties (section 6.1) 

 Creating a RAID group (section 6.2) 

 Deleting a RAID group (section 6.3) 
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6.1 Displaying RAID Group and Logical Unit Properties 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Click the Logical Status tab (refer to section 3.2.2 for a detailed description). 

3. To display the RAID group status, click the RAID Groups icon (see Figure 6.1). 

4. To display the drive configuration, select the View menu, and then select Drive 
Configuration (see Figure 6.2). 

 

Figure 6.1 Displaying RAID Group and LU Definitions 
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Figure 6.2 Displaying Drive Configuration 
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6.2 Creating a RAID Group 

To create a new RAID group: 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Click the Logical Status tab (refer to section 3.2.2 for a detailed description). 

3. Open the Create RAID Group window (see Figure 6.3) by one of the following 
methods: 

– From the Settings menu, select RAID Group, then click Create. 

– From the tool bar, click the Create New RAID Group icon ( ). 

– From the tool bar, click the RAID Groups icon, (**), select the Context menu, 
then select **. 

4. Specify the following information: 

– RAID Level 

– Drive Type 

– Drive Capacity 

– Combination (RAID level configuration) 

– Parity Groups 

5. To create a RAID group automatically, click the Automatic Selection radio button 
(see Figure 6.3), and then click OK. 

6. To create a RAID group manually, do the following: 

– Click the Manual Selection radio button, and then click Select (see Figure 6.4) 
to open the Select Drives dialog box (see Figure 6.5). 

– In Available Drives list on the bottom of the window, select the HDU number, 
hold the Shift key down, and then click the up arrow button ( ) to move that 
drive into the Drives to Use list (see Figure 6.6). 

– Click OK. 

7. Click OK on the confirmation messages. 

8. The Logical Status tab will display the new RAID group (see Figure 6.7). 
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Figure 6.3 Create RAID Group Window (automatic selection) 

 

Figure 6.4 Create RAID Group Window (manual selection)  
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Figure 6.5 Select Drives Dialog Box (before selecting drive) 

 

Figure 6.6 Select Drives Dialog Box (after selecting drive) 
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Figure 6.7 Newly Created RAID Group 
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6.3 Deleting a RAID Group 

To delete a RAID group out of set RAID groups: 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open  

– Click the Open icon ( ) on the tool bar.  

2. Click the Logical Status tab (refer to section 3.2.2 for a detailed description). 

3. Click the icon of the desired RAID group. If you want to delete more than one RAID 
group, hold the Shift key down and select the other groups.  

4. On the Settings menu, click RAID Group and Delete, and then click OK on the 
confirmation message.  

5. If there are no logical units in the RAID Group, click OK on the confirmation 
message.  

6. If the RAID group contains one or more logical units, the Logical Unit warning 
messages will display (see Figure 6.8). Depending on the type of array group, you 
might not be able to delete the RAID group without first deleting the logical units in 
that group.  

7. The Delete User Data warning message will display (see Figure 6.9). Deleting the 
RAID group will destroy any user data in that RAID group.  

8. Click Close on the Result window (see Figure 6.10).  

 

Figure 6.8 Logical Unit Warning Message 
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Figure 6.9 Delete User Data Warning Message 

 

Figure 6.10 Delete RAID Group Result Window 

 



 

184 Chapter 6   RAID Group Operations 
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Chapter 7 Logical Unit Operations 

This chapter discusses the following topics: 

 Creating a Logical Unit (section 7.1) 

 Formatting a Logical Unit (section 7.2) 

 Deleting a Logical Unit (section 7.3) 

 Changing the Default Controller (section 7.4) 

 Parity Correction (section 7.5) 
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7.1 Creating a Logical Unit 

7.1.1 Creating a Logical Unit Automatically 

1. Access the Array System Viewer window by selecting a storage array in the List 
View box, and then do one of the following: 

– Select File  Open 

– Click the Open icon ( ) on the tool bar. 

2. Click the Logical Status tab (refer to section 3.2.2 for a detailed description). 

3. Click the icon of the desired RAID group. 

4. Access the Create Logical Unit dialog box by doing one of the following: 

– On the Settings menu, click Logical Unit and click Create. 

– Click the Create New Logical Unit icon ( ) on the tool bar. 

– Right-click on the selected RAID group and select Create New Logical Unit. 

5. Input the following data: 

– Logical Unit No. 

– Default Controller 

– Size 

6. The LU will be automatically created. You cannot change the RAID group from this 
window. 

7. Click OK on the confirmation messages. 
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 Specify Number of Block, MB, or GB Increased. 

To specify a value clearly, specify the allocation (number of blocks, MBs, or GBs). 
When you allocate all the remaining capacity of the RAID group concerned, specify a 
capacity displayed on the window. 

Note: When a logical unit capacity is specified by the GB or MB, when the capacity is 
specified as the rightmost value of the slider, a logical unit with the whole free 
capacity of the RAID group to which the logical unit belongs is created. When a 
fractional capacity is included in the free capacity, a logical unit with a capacity 
including it is created. (You can see whether or not the free capacity has a fractional 
portion by viewing the Free Capacity field.) When you want to create a logical unit 
that does not have a fractional capacity, specify the logical unit using the other unit. 

Note: The relation between MB and blocks is: 1 MB = 2,048 blocks. A fraction less 
than 2,048 blocks is omitted. The relationship between GB and MB is 1 GB = 1,024 MB. 
A fraction less than 1,023 MB is omitted. 

Example:  2,048,000 blocks = 1,000 MB 
   2,049,024 blocks = 1,000 MB 

 Specify the Controller No. 

Select Controller 0 or Controller 1 to select the controller in charge of the logical 
unit. This is necessary with a dual system connection. It is not displayed with a single 
system connection. 

Note: When dual active mode is selected in the dual system, the controller in charge 
of a logical unit must be selected to set up the logical unit. Perform the logical unit 
setting, including the selection of the controller referred to in the following 
diagram. When you change a controller in charge of the logical unit, refer to 
section 7.4. 

Example: 
 

 

Dual system 

(Dual Active Mode)

HOST#1HOST#0 

Abnormal
(Switching by 
the host is 
required) 

Normal

LU1 LU0 

CTL#0 CTL#1

 

 

– Dual Active Mode: Select a controller to access from the host to the logical unit 
as the controller for the logical unit. 
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In the above drawing, CTL#0 is in charge of the logical unit0 and CTL#1 is in 
charge of the logical unit1 respectively. In this example, set up the logical unit 
by clicking optional button CTL#0 to select logical unit0 and button CTL#1 to 
select logical unit1 respectively. 

The following is a recommendation for setting an environment in Dual Active 
mode: 

a) Assign all of the LUNs from even-numbered RAID groups and define them 
using Controller 0 as the owning controller. 

b) Assign all of the LUNs from odd-numbered RAID groups and define them using 
Controller 1 as the owning controller. 

c) To maintain best configuration practices, you must ensure that both 
controllers have approximately an equal number of logical units assigned. 
Also, assigning LUNs from RAID Groups using the odd/even format (using 
steps a and b, above) will ensure the best possible performance 
expectations. 

DO NOT assign all of the even-numbered LUNs to Controller 0 and all of the odd-
numbered LUNs to Controller 1. For performance reasons, it is always better to 
have all of the LUNs created from a RAID group assigned to the same controller. 
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7.1.2 Constituting a Logical Unit Manually 
1. Click Detail. 

 

 
 

2. Select a Logical Unit No. and Default Controller, and then input Size. Click Select. 
 

 

3. Select Area No. and then click OK. 

4. Click OK. 
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5. A message displays stating the setting is complete. Click OK. 
 

 

 

 

 

The logical unit information is updated and the following window is displayed. 
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7.1.3 Using the Wizard to Create Logical Units  

To create logical units using a wizard: 

1. On the Tools menu, select Wizard  Create Logical Units. 

2. On the Select Usage drop-down list, select logical unit usage. When you select 
usage, set to the suitable parameter (Drive Type, RAID Level, and Parity). If you 
want to customize the parameter, click Customize and select the parameter (Drive 
Type, RAID Level, and Parity). 
 

 

 

 

Table 7.1 Usage for Logical Units 

Usage Recommended RAID Configuration Drive Type 

Default 4D+1P FC/SATA 

Data Base 4D+1P FC 

File System 4D+1P FC 

Backup 8D+1P FC 

Archive 8D+1P SATA 

Archive2 8D+2P SATA 

Streaming 4D+1P SATA 

Digital Surveillance System 8D+1P FC 

High Performance Computing 4D+4D FC 

3. Specify the logical unit size, number of logical units, and port(s) to use. 
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4. Click Next. 
 

 

5. The specification contents are displayed; when the specification contents are no 
problem, click Confirm. If you want to modify the contents, click Back. 
 

 
 

6. Click Done. 

The logical unit information created with the wizard can be output to a text file. 
Input a file name into the File name, and then click Done.  
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7.2 Formatting a Logical Unit 

 Format: If multiple logical units are specified, up to six logical units are formatted 
concurrently. A host I/O can be received even when formatting is being made. 

When executing Format, specify the Priority mode as occasion demands. The Format 
Priority Mode can be set by selecting:  

Logical Status  Tools  Configuration Settings Format Mode  

To format the logical unit: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the icon of a logical unit on the Array System Viewer window. On the context 
menu of the logical unit icon, click Format. 

To select multiple logical units, hold down the Ctrl key and click the icons of the 
logical units that you want to format. 
 

 



 

194 Chapter 7 Logical Unit Operations 

 

Note: Formatting may be interrupted under the following conditions: 

 A host is rebooting 

 I/O path switching 

 Access to a logical unit of the non-ownership controller 

3. A message displays requesting confirmation to format the selected logical units. 
Click OK. 

a) When there is no formatted logical unit: 
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b) When there is a formatted logical unit: 
 

 

  

 
 

The formatted logical unit information is updated and the following window displays. 
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7.3 Deleting a Logical Unit 

To delete a specified logical unit: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Logical Unit icon in the Array System Viewer window. On the context 
menu of the Logical Unit icon, select Delete. 

To select multiple logical units, hold down the Ctrl key and select the icons of logical 
units that you want to delete. 
 

 
 

3. A message displays requesting confirmation to delete a specified logical unit. Click 
OK. 

a) When a specified logical unit is not formatted: 
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b) When a specified logical unit is formatted: 
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c) When the specified logical units is formatted (multiple logical units): 
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7.4 Changing the Default Controller 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Logical Unit icon in the Array System Viewer window. On the context 
menu of the Logical Unit icon, select Change Default Controller. 
 

 
 

3. A message displays requesting confirmation to change the default controller in 
charge of a logical unit. Click OK. 

The default controller in charge of the logical unit will be changed. 
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Note: Switching the default controller which owns the logical unit, changes the default 
controller currently displayed. When switching is executed twice, the specified 
controller is changed to the original default controller controlling the logical unit. 
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7.5 Parity Correction 

Restore the logical unit in which the parity error has occurred. From the status of the 
logical unit, you can determine if a parity error has occurred. 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Logical Unit icon to which you want to correct parity, select Logical Unit 
in the Settings menu, and then select Parity Correction. 

If the parity restoration is displayed in halftone, no parity error has occurred. 
 

 
 

3. A message displays requesting confirmation to add unconnected logical units. Click 
OK. When Cancel is clicked, the parity restoration process is interrupted. 
 

 
 

A list of unconnected logical units is displayed. 
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To the top 

To the upper next line

To the lower next line

To the bottom

To be delete 

 

4. Change the order of the restoration process, when necessary. 

(The logical unit listed at the top is processed first.) 

5. Click the Start radio button in Operation and click OK. 

6. A message displays, click OK. 
 

 
 

7. A message displays stating that parity correction is started. Click OK. 
 

 
 

Storage Navigator only directs the process being performed. The microcode of the 
subsystem performs the specific operation. 

The logical unit information is updated. 
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When Skip is clicked in the Parity Correction dialog box, the following message is 
displayed: 
 

 
 

When Cancel is clicked in the Parity Correction dialog box, the following message is 
displayed: 
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Chapter 8 Host Group Operations 

Set host group 0 (000:G000) information, such as a host group option and mapping 
information. For information on creating a host group, refer to the Hitachi TagmaStore 
AMS and WMS LUN Management User’s Guide (MK-95DF703). 

This chapter discusses the following topics: 

 Setting Host Group Options (section 8.1) 

 Setting the Mapping Guard (section 8.2) 

 Specifying the Mapping Mode (section 8.3) 

 Setting the Mapping Information (section 8.4) 
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8.1 Setting Host Group Options 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Port plus signs next to the Host Groups. 

3. Click the plus sign next to Port 0A. 

4. Click the plus sign next to 000:G000, and then click Options. 

5. Click Simple Setting. 
 

 
 

6. As necessary, click Platform, Alternate path, and Failover. 
The combination, which can be chosen for every platform, is limited. 
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– Platform:  

– HP-UX 

– Solaris™ 

– AIX® 

– Windows® 2000 

– Windows® 2003 

– Linux® 

– Tru64 

– not specified 

– Alternate path:  

– not specified:  

– PV Link: Can be used by HP-UX. 

– HDLM: Can be used by Solaris, AIX, and Windows 2000/2003. 

– VxVM: Can be used by HP-UX, AIX, Solaris, Windows 2000/2003, and Linux. 

– MPxIO: Can be used by Solaris. 

– Failover:  

– not specified 

– MC/ServiceGuard: Can be used by HP-UX. 

– Sun™Cluster: Can be used by Solaris. 

– VCS: Can be used by Solaris and Linux. 

– HACMP: Can be used by AIX. 

– MSCS: Can be used by Windows 2000/2003. 

– Tru Cluster: Can be used by Tru64. 
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7. Click Additional Parameters. 
 

 
 

8. As necessary, click Item and then click OK. 

9. Click Detail. 
 

 



 
 
 

 Hitachi TagmaStore AMS/WMS Storage Navigator GUI User’s Guide      209 

10. Select Host Connection Mode 1 and Host Connection Mode 2. Select the OK button. 

– Host Connection Mode 1: 

– Normal Mode: Open system emulation mode 

– Open VMS Mode: Open VMS mode 

– TRESPASS Mode: TRESPASS mode 

– Wolfpack Mode: Wolfpack mode 

– Host Connection Mode 2: 

– HP-UX Mode: Enables the HP-UX Mode. 

– PSUE Read Reject Mode: Enables the PSUE Read Reject Mode. 

– UA(60/2A00) Suppress Mode: Suppresses the unit attention (06/2A00). 

– NACA Mode: Enables the NACA (Normal Auto Contingent Allegiance) 
Mode.  When enabled, this mode allows users who are using an AIX operating 
system to issue multiple queuing commands. This helps to improve performance, 
and is the recommended setting. 
Technical description: NACA is an LU-level condition that is triggered when a 
command (with the NACA bit set to 1) completes with CHECK CONDITION.  When 
NACA is triggered, it prevents all commands other than those with the NACA 
attribute from executing until the CLEAR ACA task management function is 
executed, while blocking all the other tasks already in the task set.  ACA is one 
of the four four task attributes - SIMPLE, ORDERED,HEAD OF QUEUE, and ACA. 

– HISUP OFF Mode: Enables the HISUP OFF Mode. 

– Reset Propagation Mode: The mode to propagate reset to other ports. 

– Unique Reserve Mode 1: Enables the Unique Reserve Mode 1. 

– ASL Report Mode (Active/Passive Group): Enables the ASL Report Mode 
(Active/Passive Group). 

– ASL Report Mode (Active/Passive): Enables the ASL Report Mode 
(Active/Passive). 

– ASL Report Mode (Active/Active): Enables the ASL Report Mode 
(Active/Active). 

– Port-ID No Report Mode: Enables the Port ID No Report Mode. 

– Port-ID Conversion Mode: Enables the Port ID Conversion Mode. 

– Tru Cluster Mode: Enables the Tru Cluster Mode. 

– Product Serial Response Mode: Enables the Product Serial Response Mode. 

– Same Node Name Mode: Enables the Same Node Name Mode. 

– CCHS Mode: Enables the CCHS convert. 

– SPC-2 Mode: Enables the SPC-2 Mode. 

11. Click OK. 

12. A confirmation message displays. Click OK. 
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The modified host group options display. 
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8.2 Setting the Mapping Guard 

If you enable the mapping guard, it will block users from performing mapping operations 
on that LU. 

1. Click the Logical Status tab on the Array System Viewer window. 

2. On the Tools menu, click Mapping Guard. 
 

 
 

3. Select the LUN or LUNS for which you want to guard the mapping and click Enable, 
then click OK. A confirmation message displays. Click OK. 
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8.3 Specifying the Mapping Mode 

Set the Mapping mode effective or ineffective. 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the plus sign next to Access Mode, and then click Mapping Mode. 
 

 
 

3. Click the Disable radio button on the Mapping Mode list, and then click Modify. 

This operation can also be done from the context menu of the list view. 

The Mapping Mode dialog box displays. 
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4. Click the Enable radio button, and then click OK. 

5. A confirmation message displays. Click OK. 
 

 

 

 

 

 
 

The setting information displays. 
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8.4 Setting Mapping Information 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Port plus sign next to the 000:G000. 

3. Click Logical Unit icon. 
 

 
 

4. Click Modify Mapping. 

The Mapping Property dialog displays. 
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5. Select one H-LUN to be added. Select one physical LUN, or several physical LUNs, 
and then click the  button. The added contents are displayed in the Mapping 
Information list. 

Note: The H-LUN that is selected will be the first LUN number that will be 
represented on the host. Typically the starting host LUN number will be -0-. For 
example, if you select HLUN -000- and then select three physical LUNs (physical 
LUNs 0003, 0004, and 0005) under “Available Logical Units”, the host will see these 
LUNs as LUNs 0, 1, and 2. The H-LUN will always represent the starting LUN number 
you would like the host to see. The actual physical LUNs will be selected under 
“Available Logical Units”. 

Note: For deletion, select the line to be deleted in Mapping Information list and 
click the  button. The deleted contents disappear from the display of Mapping 
Information list. 
 

 
 

6. Click OK. 

7. A confirmation message displays. Click OK. 
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The set mapping information is updated and the following window displays. 
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Chapter 9 Setting Target Information 

Set Target 0 (000:T000) information, such as a target option and mapping information. 
For information on creating a target, refer to the Hitachi TagmaStore AMS and WMS LUN 
Management User’s Guide (MK-95DF703). 

This section discusses the following topics: 

 Setting Target Options (section 9.1) 

 Setting the Mapping Guard (section 9.2) 

 Specifying the Mapping Mode (section 9.3) 

 Setting the Mapping Information (section 9.4) 

 Setting a CHAP User (section 9.5) 

 Setting Target Information (section 9.6) 
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9.1 Setting Target Options 

To set the target options: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Port plus signs next to the Targets. 

3. Click the plus sign next to Port 0A. 

4. Click the plus sign next to 000:T000, then click Options. 

5. Click Simple Setting. 
 

 
 

6. As necessary, select Platform, Alternate path, and Failover. 
The combination, which can be chosen for every platform, is limited. 
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– Platform:  

– HP-UX 

– Solaris™ 

– AIX® 

– Windows® 2000 

– Windows® 2003 

– Linux® 

– Tru64 

– not specified 

– Alternate path:  

– not specified 

– PV Link: Can be used by HP-UX. 

– HDLM: Can be used by Solaris, AIX, and Windows 2000/2003. 

– VxVM: Can be used by HP-UX, AIX, Solaris, Windows 2000/2003, and Linux. 

– MPxIO: Can be used by Solaris. 

– Failover:  

– not specified 

– MC/ServiceGuard: Can be used by HP-UX. 

– Sun™ Cluster: Can be used by Solaris. 

– VCS: Can be used by Solaris and Linux. 

– HACMP:  Can be used by AIX. 

– MSCS: Can be used by Windows 2000/2003. 

– Tru Cluster: Can be used by Tru64. 
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7. Click Additional Parameters. 
 

 
 

8. As necessary, click Item and click OK. 

9. Click Detail. 
 

 
 

10. Click Host Connection Mode 1 and Host Connection Mode 2. Click OK: 

– Host Connection Mode 1: 

– Normal Mode: Open system emulation mode 

– Open VMS Mode: Open VMS mode 

– TRESPASS Mode: TRESPASS mode 

– Wolfpack Mode: Wolfpack mode 
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– Host Connection Mode 2: 

– HP-UX Mode: Enables the HP-UX Mode. 

– PSUE Read Reject Mode: Enables the PSUE Read Reject Mode. 

– UA(60/2A00) Suppress Mode: Suppresses the unit attention (06/2A00). 

– NACA Mode: Enables the NACA Mode. 

– HISUP OFF Mode: Enables the HISUP OFF Mode. 

– Reset Propagation Mode: The mode to propagate reset to other ports. 

– Unique Reserve Mode 1: Enables the Unique Reserve Mode 1. 

– ASL Report Mode (Active/Passive Group): Enables the ASL Report Mode 
(Active/Passive Group). 

– ASL Report Mode (Active/Passive): Enables the ASL Report Mode 
(Active/Passive). 

– ASL Report Mode (Active/Active): Enables the ASL Report Mode 
(Active/Active). 

– Port-ID No Report Mode: Enables the Port ID No Report Mode. 

– Port-ID Conversion Mode: Enables the Port ID Conversion Mode. 

– Tru Cluster Mode: Enables the Tru Cluster Mode. 

– Product Serial Response Mode: Enables the Product Serial Response Mode. 

– Same Node Name Mode: Enables the Same Node Name Mode. 

– CCHS Mode: Enables the CCHS convert 

– SPC-2 Mode: Enables the SPC-2 Mode. 

11. Click OK. 

12. A confirmation message displays. Click OK. 
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The modified target options display. 
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9.2 Setting the Mapping Guard 

If you enable the mapping guard, it will block users from performing mapping operations 
on that LU. 

1. Click the Logical Status tab on the Array System Viewer window. 

2. On the Tools menu, select the Mapping Guard. 
 

 
 

3. Select the LUN or LUNS for which you want to guard the mapping and click Enable, 
then click OK. A confirmation message displays. Click OK. 
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9.3 Specifying the Mapping Mode 

Set the Mapping mode effective or ineffective. 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the plus sign next to Access Mode, and then click Mapping Mode. 
 

 
 

3. Click the Disable radio button on the Mapping Mode list, and then click Modify. (This 
operation can also be done from the Context menu of the List View.) 

The Mapping Mode dialog displays. 
 

 
 

4. Click the Enable radio button, and then click OK. 
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5. A confirmation message displays. Click OK. 
 

 

 

 

 

 
 

The setting information displays. 
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9.4 Setting the Mapping Information 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Port plus sign next to the 000:T000. 

3. Click Logical Unit icon. 
 

 
 

4. Click Modify Mapping. 

The Mapping Property dialog box displays. 
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5. Select one H-LUN to be added. Select one physical LUN, or several physical LUNs, 
and then click the  button. The added contents are displayed in the Mapping 
Information list. 

Note: The H-LUN that is selected will be the first LUN number that will be 
represented on the host. Typically the starting host LUN number will be -0-. For 
example, if you select HLUN -000- and then select three physical LUNs (physical 
LUNs 0003, 0004, and 0005) under Available Logical Units, the host will see these 
LUNs as LUNs 0, 1, and 2. The H-LUN will always represent the starting LUN number 
you would like the host to see. The actual physical LUNs will be selected under 
Available Logical Units. 

Note: For deletion, select the line to be deleted in Mapping Information list and 
click the  button. The deleted contents disappear from the display of Mapping 
Information list. 
 

 
 

6. Click OK. 

7. A confirmation message displays. Click OK. 
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The set mapping information is updated and the following window displays. 
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9.5 Setting a CHAP User 

9.5.1 Adding a CHAP User 

To add the CHAP user: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Port plus signs next to the CHAP User and click CHAP User. 

 

3. Click Add. 

The CHAP User dialog box displays. 
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4. In the CHAP User dialog box, enter the User Name, Secret, and Secret 
Confirmation. 

5. From the Available Targets list, select the target to be assigned, click the  
button. 

– User Name: Enter the name of the User with 256 or less alphanumeric character. 
The following symbols can be used. 

(.  -  +  @  _  =  :  /  [  ]   ~  (space)) 

– Secret: Enter the Secret from 12 through 32 alphanumeric characters. The 
following symbols can be used. 

(.  -  +  @  _  =  :  /  [  ]   ~  (space)) 

– Secret Confirmation: Enter the characters that enter into the Secret. 

6. Click OK. 

7. A confirmation message displays. Click OK. 
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9.5.2 Changing the CHAP User 

To change the CHAP user: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Port plus signs next to the CHAP User and click CHAP User. 
 

 
 

3. Select the CHAP User to be changed from the CHAP User list. 

4. Click Modify. 

The CHAP User dialog box displays. 
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5. As necessary, enter the User Name, Secret, and Secret Confirmation. 

6. As necessary, change the assigned target, and click OK. 

7. A confirmation message displays. Click OK. 
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9.5.3 Deleting the CHAP User 

To delete the CHAP user: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Port plus signs next to the CHAP User and click CHAP User. 

3. Select the CHAP User to be deleting from the CHAP User list. 
 

 
 

4. A confirmation message displays. Click OK. 
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9.6 Setting Target Information 

9.6.1 Changing Target Information 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Port. 

3. Select the Target to be changed from the Target list. 
 

 
 

4. Click Modify. 

The Target dialog box displays. 
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5. Enter the Alias, Authentication Method, CHAP Information, and iSCSI Name: 

– Alias: Enter the alias of the Target with 32 or less alphanumeric character: 

(Excluding  \, /, : , , , ;, *, ?, “, <, >, | and ‘) 

Spaces at the top or end are ignored. An identical name cannot be used in an 
identical Port. 

– Authentication Method: Select the CHAP, None, or CHAP, None. 

– CHAP Information: 

– CHAP Algorithm: Displayed MD5 always. 

– Two-Way Authentication: Select the Enable or Disable radio button. 

When clicking the Enable radio button, specify the following items. 

User Name: Enter the name of the User with 256 or less alphanumeric 
character. The following symbols can be used. 
(.  -  +  @  _  =  :  /  [  ]  ~  (space)) 

Secret: Enter the Secret from 12 through 32 alphanumeric characters. 
The following symbols can be used. 
(.  -  +  @  _  =  :  /  [  ]  ~  (space)) 

Secret Confirmation: Enter the characters that enter into the Secret. 

– iSCSI Name: Enter the name of the iSCSI Name with 223 or less alphanumeric 
character. A period (.), hyphen (-), and colon (:) can be used. 

6. Click OK. 

7. A confirmation message displays. Click OK. 
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9.6.2 Initializing Target 0 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the Port. 

3. Select the Target to be initialized from the Target list. 
 

 
 

4. Click Initialize. 
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5. A confirmation message displays. Click OK. 
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Chapter 10 NAS Operations 

This section discusses the following topics: 

 Setting NNC LAN Information (section 10.1) 

 Setting NAS System Logical Units (section 10.2) 

 Setting NAS User Logical Units (section 10.3) 

 Shutdown/Booting/Rebooting NNC (section 10.4) 

Figure 10.1 displays an example of a host computer connection, in which the Storage 
Navigator is installed, and the disk array subsystem to which the NNC option has been 
added. 

 

10BaseT/100BaseT twisted pair cable 

Switch

LAN

Workstation

Array Unit 
(dual system) 

CTL1 LAN 

CTL0 LAN 

LAN

NTP Server

nnc1 LAN 

nnc0 LAN 

 

Figure 10.1 Disk Array Subsystem to which NNC Option Added (management ports) 
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10.1 Setting the NNC LAN Information 

To set the NNC LAN information for management port: 

Note: A cluster becomes a stop state when you change an IP address or subnet mask. 

1. On the Tools menu, select Configuration Settings. Alternatively, click : 
Configuration Settings in the tool bar. 

2. Click the NNC LAN tab. 
 

 
 

– Network: Specify IP Address, Subnet Mask, MTU, and Negotiation, which is part 
of the LAN information. 

3. Click Apply. 

4. A message displays. Click OK. 
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10.2 Setting NAS System Logical Units 

Note: The NAS system logical units are usually set at the factory shipment, so that a user 
is not required to set them. 

Nine logical units for the NAS system are required, and the following capacity is at least 
necessary. When no logical unit is available for allocating to the logical unit for the NAS 
system, create it referring to Figure 6.3. 

For NNC Type2    For NNC Type1 

  

To set the NAS system logical units: 

10.2.1 For NNC Type2 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the NAS plus signs next to the NNC0/2. 

3. Click the NNC0/2 plus signs next to the System. 
 

 

4. Click Set. 
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The System LU dialog box displays. 
 

 
 

5. Click Select next to the wanted System LUs. 

The Select Logical Unit dialog box displays. 
 

 
 

6. Click LUN to set the system LU, and then click OK. 

The selected LUN displays. 

7. Repeat steps 5 to 6 and complete a System LU list. 
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8. Click OK. 

9. A message displays. Click OK. 
 

 

 

 
 

The set system LU is updated and the following window displays. 
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10.2.2 For NNC Type1 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the NAS plus signs next to the NNC0/2. 

3. Click the NNC0/2 plus signs next to the System. 
 

 

4. Click Set. 
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The System LU dialog box displays. 
 

 
 

5. Click Select next to the wanted System LUs. 

The Select Logical Unit dialog box displays. 
 

 
 

6. Click LUN to set the system LU, and then click OK. 

The selected LUN displays. 

7. Repeat steps 5 to 6 and complete a System LU list. 
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8. Click OK. 

9. A message displays. Click OK. 
 

 

 

 
 

The set system LU is updated and the following window displays. 
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10.3 Setting NAS User Logical Units 

When no logical unit is available for allocating to the logical unit for the NAS user, create 
it referring to section 7.1. 

To set the NAS user logical units: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the NAS plus signs next to the NNC0/2. 

3. Click the NNC0/2 plus signs next to the User. 
 

 
 

4. Click Set. 

The User LU dialog box displays. 
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5. Select one H-LUN to be added. Select one LUN and click the  button. The 
added contents are displayed in Logical Unit for User Volume list. 

6. Repeat step 5 and complete a User LU list. 
 

 
 

To cancel the assigned user LU, select the H-LUN to be canceled in Logical Unit for 
User Volume list and click the  button. 

The selected H-LUN moved to the Available Logical Units list. 

7. Click OK. 
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8. A message displays. Click OK. 
 

 

 

 
  

The set User LU is updated and the following window displays. 
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10.4 Shutdown/Booting/Rebooting NNC 

10.4.1 Shutdown the NNC 

To shutdown the NNC: 

1. First make sure that the cluster status is Active, and the resource group status is 
either online or offline. If it is not, reboot the NNC. 

2. Click the Logical Status tab on the Array System Viewer window. 

3. Click the NAS icon; select the NNC number on the NNC Status list. 
 

 
 

– NNC Status: Status of NAS OS: 

– ACTIVE: NAS OS is active and the Node is in operation. 

– BOOT: NAS OS is in boot process. 

– DISUSE: The controller is blocked. 

– DOWN: NAS OS is abnormally stopped. 

– DUMP: A NAS Dump is being collected. 

– HUNGUP: NAS OS is hung-up. 

– INACTIVE: NAS OS is in operation and the Node is stopped. 

– INST: NAS OS is in installation process. 

– NEW: NAS OS is not installed. 

– SHUTDOWN: NAS OS is in shutdown process. 

– STOP: NAS OS is normally stopped. 

– WARN: NAS Manager is not installed, or NAS OS is in operation and the status 
of the Node is unknown. 
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4. Click Shutdown. 

5. A message displays. Click OK. 
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10.4.2 Booting the NNC 

Note: There is no difference between the boot and reboot operations. Do not specify 
anything for the boot option. 

To boot the NNC: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the NAS icon; select the NNC number on the NNC Status list. 
 

 
 

3. Click Boot. 

4. A message displays. Click OK. 
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10.4.3 Rebooting the NNC 

To reboot the NNC: 

1. Click the Logical Status tab on the Array System Viewer window. 

2. Click the NAS icon; select the NNC number on the NNC Status list. 
 

 
 

3. Click Reboot. 

4. A message displays. Click OK. 
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Chapter 11 Displaying Statistical Information 

This section discusses the following topics: 

 Displaying the Controller Use Condition (section 11.1) 

 Displaying the Numbers of Host Commands Received (section 11.2) 

 Displaying the Command Execution Condition (section 11.3) 

 Displaying the Cache Load Condition (section 11.4) 
  



 

260 Chapter 11 Displaying Statistical Information 

11.1 Displaying the Controller Use Condition 

 From the Tools menu, select Statistical Information or click : Statistical 
Information in the tool bar. 

The Controller Use Condition window displays (see Figure 11.1). 

 

Figure 11.1 Displaying Controller Use Condition 
 

– Array Time 

– Controller being active for (Integrated): Integrated active time of the array 
unit (minute). This is the accumulated time from the initial power-on to the 
power-off. 

– Power on for (Work): The accumulated time from the power-on of the 
subsystem to the present time. It is displayed by milliseconds. 

– Controller 

– Powered on counts: Integrated number of power ON times (at interruption) 
of the controller 

– H-SCSI reset counts: Integrated number of host bus SCSI reset times (total of 
interruptions and messages) of the controller (Not supported) 
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11.2 Displaying the Numbers of Host Commands Received 

 Click the Host Commands tab. 

 

Figure 11.2 Displaying Number of Host Command Received 
 

– LU: Logical unit number 

– Read: Accumulated number of received read commands in each logical unit. 

– Write: Accumulated number of received write commands in each logical unit. 
 



 

262 Chapter 11 Displaying Statistical Information 

11.3 Displaying the Command Execution Condition 

 Click Execution tab. 

 

Figure 11.3 Displaying Command Execution Condition 
 

– A:Logical Unit: Logical unit number 

– B:Read Cache Hits: Total of READ commands (hitting cache or partially hitting 
cache) 

– C:Write Cache Hits: Total of WRITE commands (cache read hits) 

– D:Sequential Read: Total of READ commands (recognized as sequential reading) 

– E:Sequential Write: Total of WRITE commands (recognized as sequential writing) 

– F:Prefetch Stagings: Total of prefetch jobs executed 

– G:Write Through Operation: Total of WRITE or WRITE & VERIFY commands 
(substituted by Write-Through operations) 

– H:Reassigned Blocks: Number of re-assigned blocks (Not supported) 
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11.4 Displaying the Cache Load Condition 

 Click Cache Load tab. 

 

Figure 11.4 Displaying Cache Load Condition 
 

– Number of Inflow Threshold Reached: Total number of occurrences of inflow 
limitations 

This equipment manages the amount of data in cache as an inflow limit. When the 
host tries to write data exceeding this limit, an inflow limitation occurs. In this case, 
the write request from the host waits until part of write data is transferred to the 
drive. 
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Chapter 12 Acquiring Performance Information 

In statistics information, the command operation state is output for each logical unit in 
the array unit. The command operation state consists of three types of data: the number 
of received commands, the number of cache-hit commands, and the cache hit rate for 
each Read or Write command. 

This section includes: 

 Setting a Collection of Performance Statistics (section 12.1) 

 Outputting Statistics Information Automatically to a Text File (section 12.2) 

 Outputting Performance Statistics Information Manually to a Text File (section12.3 ) 

 Outputting Performance Statistics Information Automatically to a Text File  
(section 12.4 ) 
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12.1 Setting a Collection of Performance Statistics 

To select items from the collection of performance statistics: 

1. On the Tools menu, select Performance  Settings. 

The Performance Statistics dialog box displays. 
 

 
 

2. Select items from the Collection of Performance Statistics. 

3. Click OK. 

The following message displays. Click OK. 
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12.2  Outputting Statistics Information Automatically to a Text File 

To select items from the collection of performance statistics: 

On the Tools menu, select Performance  Settings. 

The Performance Statistics dialog box displays. 
 

 
 

Select items from the Collection of Performance Statistics. 

Click OK. 

The following message displays. Click OK. 
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12.3 Outputting Performance Statistics Information Manually to a Text File 

1. From the Tools menu, select Performance  Output File or click : Performance 
on the tool bar. 
 

 
 

2. Select the name of the component (Port, RAID Groups, Logical Unit, Cache, 
Processor, Drive, Drive Operation, or Back-end), information that you need for 
each controller. 

3. Specify the extent to be output clicking Select, excluding the Cache and Processor. 
When the extent is not specified, all is output. For example, when you want to 
specify an extent of information on the Logical Unit, click the Logical Unit icon, 
click Select, and then specify the extent of the Logical Unit. 
 

   

4. Select the number of the first one of LUs you do not want to output, scroll the LU 
numbers with the slider keeping the Shift key being pressed, and then select the 
number of the last LU. 

5. Click OK. 

6. Click the Manual radio button. 
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7. When you want to make an output as an addition to the information previously 
output, check the Collectively output check box. Do not check it when you want to 
overwrite the information previously output. 

8. Specify the output directory or click Browse. If the output directory is omitted, it 
will be output to the directory where the Storage Navigator is installed. 
 

 
 

9. Click Start. 

10. Click Get Data. 
 

 
 

a) When the Collectively output is not specified: 

These files are output in the text file format. 

: pfm$$$$$.txt ($$$$$: serial number from 00000 to 19999) 
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Note: Files are output with the names of pfm00000.txt to pfm19999.txt. After 
pfm19999.txt, pfm00000.txt is overwritten. Transfer necessary information to 
another directory. 

The information is acquired according to the following timing. 
 

 Get dataGet dataGet dataGet data 

pfm00002.txtpfm00001.txtpfm00000.txt
 
 

b) When the Collectively output is specified: 

This file is output in the text file format (pfm.txt). 

11. After the file processed is terminated, a confirmation message displays. Click OK. 
 

 
 

12. Click Stop. 

When the single system is connected, only the information of the controller 0 side is 
collected. 

Note: When the whole information is output to files once, the size of the output 
data is 500 kB for the AMS500. The data size varies in proportion to the number of 
times of outputs specified. To output the whole information to files 20,000 times 
using the AMS500 a disk capacity of approximately 10 GB is required. 
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Output number Information getting time
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– No.: Output number 

– Information getting time: Time and date when the information is acquired. 

– CTL: Controller number 

– Port: Port number 

– IO Rate (IOPS): Number of Read/Write commands received per second. 

– Read Rate (IOPS): Number of Read commands received per second. 

– Write Rate (IOPS): Number of Write commands received per second. 

– Read Hit (%): Rate of the number of the Read commands, which could cache-
hitting, out of the Read commands received in the specified period. 

– Write Hit (%): Rate of the number of the Write commands, which could write 
data immediately to the cache, out of the Write commands received in the 
specified period. 

– Trans. Rate (MB/S): Transfer size of Read/Write commands per second. 

– Read Trans. Rate (MB/S): Transfer size of Read commands per second. 

– Write Trans. Rate (MB/S): Transfer size of Write commands per second. 

– Read CMD Count: Received number of Read commands. 

– Write CMD Count: Received number of Write command. 

– Read CMD Hit Count: Number of the Read commands that had been cache-hit. 

– Write CMD Hit Count: Number of the Write commands, which could write data 
immediately to the cache. 

– Read Trans. Size (MB): Transfer size of Read commands. 

– Write Trans. Size (MB): Transfer size of Write commands. 

– RG: RAID group number 

– LU: Logical unit number 

– Read CMD Hit Count2: Number of the Hit Read Special Path commands out of 
the read commands that made cache hits. 

– Read CMD Hit Time(microsec.): The average response time of the Hit Read 
Special Path command. 
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– Read CMD Hit Max Time(microsec.): The maximum response time of the Hit 
Read Special Path command. 

– Write CMD Hit Count2: Number of the Write Special Path commands out of the 
Write commands, which could write data immediately to the cache. 

– Write CMD Hit Time(microsec.): The average response time of the Write Special 
Path command. 

– Write CMD Hit Max Time(microsec.): The maximum response time of the Write 
Special Path command. 

– Read CMD Miss Count: The number of the Miss Read Special Path commands out 
of the Read commands that made no cache hits. 

– Read CMD Miss Time(microsec.): The average response time of the Miss Read 
Special Path command. 

– Read CMD Miss Max Time(microsec.): The maximum response time of the Miss 
Read Special Path command. 

– Write CMD Miss Count: The number of the Random Write Special Path 
commands that could complete the high-speed process up to the parity 
generation that is an extended process of the Write command. 

– Write CMD Miss Time(microsec.): The average response time of the Random 
Write Special Path command. 

– Write CMD Miss Max Time(microsec.): The maximum response time of the 
Random Write Special Path command. 

– Read CMD Job Count: The number of the Read commands that could not 
perform the high-speed process. 

– Read CMD Job Time(microsec.): The average response time of the Read 
command job. 

– Read CMD Job Max Time(microsec.): The maximum response time of the Read 
command job. 

– Write CMD Job Count: The number of the Write commands that could not 
perform the high-speed process. 

– Write CMD Job Time(microsec.): The average response time of the Write 
command job. 

– Write CMD Job Max Time(microsec.): The maximum response time of the Write 
command job. 

– Read Hit Delay CMD Count(<300ms): The number of commands, whose 
response time is less than 300 ms, out of the Hit Read Special Path commands. 

– Read Hit Delay CMD Count(300-499ms): The number of commands, whose 
response time is in a range of 300 ms to 499 ms, out of the Hit Read Special Path 
commands. 

– Read Hit Delay CMD Count(500-999ms): The number of commands, whose 
response time is in a range of 500 ms to 999 ms, out of the Hit Read Special Path 
commands. 

– Read Hit Delay CMD Count(1000ms-): The number of commands, whose 
response time is 1000 ms or more, out of the Hit Read Special Path commands. 

– Write Hit Delay CMD Count(<300ms): The number of commands, whose 
response time is less than 300 ms, out of the Write Special Path commands. 
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– Write Hit Delay CMD Count(300-499ms): The number of commands, whose 
response time is in a range of 300 ms to 499 ms, out of the Write Special Path 
commands. 

– Write Hit Delay CMD Count(500-999ms): The number of commands, whose 
response time is in a range of 500 ms to 999 ms, out of the Write Special Path 
commands. 

– Write Hit Delay CMD Count(1000ms-): The number of commands, whose 
response time is 1000 ms or more, out of the Write Special Path commands. 

– Read Miss Delay CMD Count(<300ms): The number of commands, whose 
response time is less than 300 ms, out of the Miss Read Special Path commands. 

– Read Miss Delay CMD Count(300-499ms): The number of commands, whose 
response time is in a range of 300 ms to 499 ms, out of the Miss Read Special 
Path commands. 

– Read Miss Delay CMD Count(500-999ms): The number of commands, whose 
response time is in a range of 500 ms to 999 ms, out of the Miss Read Special 
Path commands. 

– Read Miss Delay CMD Count(1000ms-): The number of commands, whose 
response time is 1000 ms or more, out of the Miss Read Special Path commands. 

– Write Miss Delay CMD Count(<300ms): The number of commands, whose 
response time is less than 300 ms, out of the Random Write Special Path 
commands. 

– Write Miss Delay CMD Count(300-499ms): The number of commands, whose 
response time is in a range of 300 ms to 499 ms, out of the Random Write Special 
Path commands. 

– Write Miss Delay CMD Count(500-999ms): The number of commands, whose 
response time is in a range of 500 ms to 999 ms, out of the Random Write Special 
Path commands. 

– Write Miss Delay CMD Count(1000ms-): The number of commands, whose 
response time is 1000 ms or more, out of the Random Write Special Path 
commands. 

– Read Job Delay CMD Count(<300ms): The number of commands, whose 
response time is less than 300 ms, out of the Read command job. 

– Read Job Delay CMD Count(300-499ms): The number of commands, whose 
response time is in a range of 300 ms to 499 ms, out of the Read command job. 

– Read Job Delay CMD Count(500-999ms): The number of commands, whose 
response time is in a range of 500 ms to 999 ms, out of the Read command job. 

– Read Job Delay CMD Count(1000ms-): The number of commands, whose 
response time is 1000 ms or more, out of the Read command job. 

– Write Job Delay CMD Count(<300ms): The number of commands, whose 
response time is less than 300 ms, out of the Write command job. 

– Write Job Delay CMD Count(300-499ms): The number of commands, whose 
response time is in a range of 300 ms to 499 ms, out of the Write command job. 

– Write Job Delay CMD Count(500-999ms): The number of commands, whose 
response time is in a range of 500 ms to 999 ms, out of the Write command job. 

– Write Job Delay CMD Count(1000ms-): The number of commands, whose 
response time is 1000 ms or more, out of the Write command job. 

– Tag Count: The maximum number of tags in the specified period. 
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– Cache Write Pending Rate (%): Rate of cache usage capacity (middle+physical) 
within the cache capacity. 

– Cache Clean Queue Usage Rate (%): Rate of clean cache usage 

– Cache Middle Queue Usage Rate (%): Rate of middle cache usage 

– Cache Physical Queue Usage Rate (%): Rate of physical cache usage 

– Cache Total Queue Usage Rate (%): Rate of total cache usage 

– Partition: Partition number 

– Usage (%): Operation rate of the processor 

– Host-Cache Bus Usage Rate (%): The use rate of the bus between the host and 
the cache. 

– Drive-Cache Bus Usage Rate (%): The use rate of the bus between the drive and 
the cache. 

– Processor-Cache Bus Usage Rate (%): The use rate of the bus between the 
processor and the cache. 

– Cache (DRR) Bus Usage Rate (%): The use rate of the bus between the parity 
generation circuit (DRR) and the cache. 

– Dual Bus Usage Rate (%): The use rate of the bus between the controllers. 

– Total Bus Usage Rate (%): The total use rate of the cache bus. 

– Unit: Unit number 

– HDU: HDU number 

– Online Verify. Rate (IOPS): Number of Online Verify commands per second 

– Online Verify CMD Count: Number of Online Verify commands 

– Operating Rate (%): Operation rate of the drive 

– Tag Count: Number of Tag 

– Unload Time (min.): Unload time of the drive 

– Path: Path number 

– Loop: Loop number 
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12.4 Outputting Performance Statistics Information Automatically to a Text File 

Command operation state for each logical unit in the array unit is output at the specified 
intervals by the specified times. 

1. From the Tools menu, select Performance. Alternatively, click : Performance in 
the tool bar. 
 

 
 

2. Select the name of the component (Port, RAID Groups, Logical Unit, Cache, 
Processor, Drive, Drive Operation, or Back-end), information on which you want to 
get, for each controller. 

3. Specify the extent to be output clicking Select, excluding the Cache and Processor. 
When the extent is not specified, all is output. For example, when you want to 
specify an extent of information on the logical unit, click the Logical Unit icon, click 
Select, and then specify the extent of the logical unit. 

4. Click the Auto radio button. 

5. Specify the Interval Time and Get Count Times. 

6. When you want to make an output as an addition to the information previously 
output, check the Collectively output check box. Do not check it when you want to 
overwrite the information previously output. 
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7. Input the output directory or click Browse. If the output directory is omitted, it will 
be output to the directory where the Storage Navigator is installed. 
 

 
 

8. Click Start. 
 

 
 

a) When the Collectively output is not specified: 

These files are output in the text file format. 

: pfm$$$$$.txt ($$$$$: serial number from 00000 to 19999) 

Note: Files are output with the names of pfm00000.txt to pfm19999.txt. After 
pfm19999.txt, pfm00000.txt is overwritten. Transfer necessary information to 
another directory. 

b) When the Collectively output is specified: 

This file is output in the text file format (pfm.txt). 
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9. After the file processed is terminated, a confirmation message displays. Click OK. 
 

 
 

When the single system is connected, only the information of the controller 0 side is 
collected. 

The format to the file to be retrieved is the same as that of the file retrieved 
manually. 

Note: When the whole information is output to files once, the size of the output 
data is 500 kB in the cases of the AMS500. The data size varies in proportion to the 
number of times of outputs specified. To output the whole information to files 
20,000 times using the AMS500, a disk capacity of approximately 10 GB is required. 
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Chapter 13 Tuning Parameters 

The tuning parameters include parameters concerning the system and the logical unit. 

This section discusses the following topics: 

 Multi Stream Tuning Parameters (section 13.1) 

 Pre-Fetch Parameters (section 13.2) 

 System Tuning Parameters (section 13.3) 
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13.1 Multi Stream Tuning Parameters 

1. From the Tools menu, select the Tuning Parameter on the Unit window. 

The Tuning Parameter window displays. 
 

 
 

– Scope: Select System or Logical Unit. 

– Mode / Prefetch Information: 

– LUN: Displays All 

– Mode: Displays Normal, Read, Write, or Read/Write 

– Prefetch Next: Displays Disable or Enable 

– Prefetch Criteria: Displays Base or Fixed 

2. When you want to modify the setting, click Modify. 

The Prefetch Multi Stream (System) dialog box displays. 
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– Mode: Specify the mode: 

– Read: When you select the Read mode, specify the Prefetch Next Enable or 
Disable. 

– Write: When you select the Write mode, cannot specify the Prefetch Next. 

– Prefetch Criteria: Specify the pre-fetch criteria. 

3. Specify the parameters; click OK. 

4. Click the Logical Unit on the Scope. 
 

 
 

– Scope: Select System or Logical Unit. 

– Mode / Prefetch Information: 

– LUN: Displays logical unit number 

– Mode: Displays Normal, Read, Write, or Read/Write 

– Prefetch Next: Displays Disable or Enable 

– Prefetch Criteria: Displays Base or Fixed 

5. Select the LUN to modify the setting. Then click Modify. 
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The Prefetch Multi Stream (Logical Unit) dialog box displays. 

 
 

– Logical Unit No.: Displays the logical unit number. 

– Mode: Specify the mode: 

– Read: When you select the Read mode, specify the Prefetch Next Enable or 
Disable. 

Note: You can specify only Fixed in the Prefetch Criteria. 

– Write: When you select the Write mode, cannot specify the Prefetch Next. 

– Prefetch Criteria: Specify the pre-fetch criteria. 

6. Specify the parameters; click OK. 

7. Click Apply. 

8. A message displays stating that the setting is complete. Click OK. 
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To initialize the Multi Stream parameters: 

1. When you want to initialize the multi stream parameters, click Default. 

2. A message displays stating that the setting is complete. Click OK. 
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13.2 Pre-Fetch Parameters 

1. From the Tools menu, select the Tuning Parameter on the Unit window. 

The Tuning Parameter window displays. 

2. Click the Prefetch tab. 

The Tuning Parameter window displays. 
 

 
 

– Count of Judgment Sequential: Specify the count of judgment sequential. 

3. Select the LUN you want to modify the pre-fetch size, and then click Modify. 

The Prefetch Staging Size dialog box displays. 
 

 

4. Specify the Prefetch Size, click OK. 

5. Click Apply. 
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6. A message displays stating that the setting is complete. Click OK. 
 

 

 

 
 

To initialize the prefetch parameters: 

1. When you want to initialize the prefetch parameters, click Default. 

2. A message displays stating that the setting is complete. Click OK. 
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13.3 System Tuning Parameters 

1. From the Tools menu, select the Tuning Parameter on the Unit window. 

The Tuning Parameter window displays. 

2. Click the System tab. 
 

 
 

– Dirty Data Opportunity: Specify an occasion to de-stage dirty data (%). 

– Dirty Data Stop Opportunity: Specify an occasion to stop the de-staging of dirty 
data (%). 

– Cache Control Mode: Specify the cache control mode. 

– Detailed Trace Mode: Specify the detailed trace mode. 

3. Click Apply. 

4. A message displays stating that the setting is complete. Click OK. 
 

 

 



 

288  Chapter 13 Tuning Parameters 

 
 

5. Initialize the System parameters 

6. When you want to initialize the system parameters, click Default. 

7. A message displays stating that the setting is complete. Click OK. 
 

 

 

 
 



 
 
 

 Hitachi TagmaStore AMS/WMS Storage Navigator GUI User’s Guide      289 

Chapter 14 ACE Tool 

When you use the ACE Tool, you can get a connection diagram of the ENC wiring 
between the additional disk array units and addresses of the additional disk array units 
that have been set. 

This section discusses the following topics: 

 Automatic Setting (section 14.1) 

 Constituting a Cabinet Using the Output File of Storage Navigator (section 14.2) 

 Detail of the Cable Figure (section 14.3) 
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14.1 Automatic Setting 

1. From the Tool menu, select the ACE Tool on the Main window. 

The Selection for the Subsystem Type displays. 
 

 
 

2. Select the subsystem you want to get the connection diagram of the ENC wiring 
between them and addresses of them that have been set, and then click OK. 
 

 

3. Click Base. 
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4. Enter a number of disk array units connected to the RKM/RKAJ(Fibre), 
RKS/RKAJ(Fibre) or RKXS. 

Note: The supported expansion cabinets of the DF700XS (WMS100) are currently 
RKAAT/RKAJAT, but select RKAAT for RKAATL and RKAJAT for RKAJATL. It is 
displayed as RKAAT for RKAATL and RKAJAT for RKAJATL. 

– DF700XS (WMS100): The total number of the RKXS and RKAJAT(SATA)/RKAAT 
(SATA) is not more than 7; the RKXS is one. 

– DF700S (AMS200): The total number of the RKS/RKAJs (Fibre) and RKAJATs 
(SATA) is not more than 7; the RKS/RKAJs(Fibre) is one or more. 

– DF700M (AMS500): The total number of the RKM/RKAJs(Fibre) and RKA 
(Fibre)/RKAJATs (SATA)/RKAATs (SATA) is not more than 15; the 
RKM/RKAJs(Fibre) is one or more. 

– DF700H/DF700HE (AMS1000): The total number of the RKAJs(Fibre) and 
RKA(Fibre)/RKAJATs (SATA)/RKAATs(SATA) is not more than 30; the RKAJs(Fibre) 
is one or more. 
 

 

5. Click OK. 

The ENC wiring connection diagram and addresses of the additional disk array units 
that have been set are created automatically. 
 

 
 

6. Click Cable figure. 
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The Cable Figure displays. 
 

 

7. Copy and paste the wiring cable figure that has been created when necessary. Click 
End. 

8. Save the information that has been set by clicking Save. 

The Save as dialog box displays. 
 

 
 

9. Specify the File name and click Save. 
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10. Click OK. 
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14.2 Constituting a Cabinet using the Storage Navigator Output File 

When the ACE tool is started after the Array System Viewer window is opened, the 
wiring diagram is generated based on the information displayed in the Array System 
Viewer window. 

1. From the Tool menu, select the ACE Tool on the Main window. 

The Selection the Subsystem Type dialog box displays. 
 

 
 

2. Click File input. 

The Open File dialog box displays. 
 

 
 

3. Specify the File name and click Open. 

For AMS 200/500/1000: use the file of parts information. 

For 9570V/9520V/1000: use the file of RAID group/logical unit definition information. 
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The Max number of disk units dialog box displays. 
 

 
 

4. Since a number of disk array units (12) that can be mounted on the Rack1 and Rack2 
are displayed, check it and click OK. 

Configuration information displays. 
 

 
 

5. Click Edit on the left side (Logical section). 
 

 
 

6. Click OK. 
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The Configuration window displays. 
 

 
 

7. Select the location where you want to edit. 

The Unit Select dialog box displays. 
 

 
 

8. Specify the RKAJ(Fibre), RKAJAT(SATA), or Empty, and then click OK . 

An error message is displayed, if you specify the location or disk array unit type that 
do not allow the rack addition. Specify the correct location and disk array unit type. 
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9. Click Create. 

The Configuration window is updated. 
 

 
 

10. Click Cable figure. 
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The Cable Figure window displays. 
 

 
 

11. Copy and paste the wiring cable figure that has been created when necessary. Click 
End. 

12. Click End. 

14.3 Cable Figure Detail 

A: Number of cables of the Path 0 
B: Number of cables of the Path 1 
C: Color of the binders attached to the both ends of the ENC cable 
D: Number of cables of the Path 0 
E: A number of long inter-rack cables of the Path 0 
F: Number of cables of the Path 1 
G: A number of long inter-rack cables of the Path 1 
H: Number of cables of the Loop 0 
I: Number of cables of the Loop 1 
J: A number of cables of the Path 0 that are connected to the selected disk array units 

or added to the additional disk array unit. 
K: A number of long inter-rack cables of the Path 0 that are connected to the selected 

disk array units or added to the additional disk array unit. 
L: A number of cables of the Path 1 that are connected to the selected disk array units 

or added to the additional disk array unit. 
M: A number of long inter-rack cables of the Path 1 that are connected to the selected 

disk array units or added to the additional disk array unit. 

A B C D E C F G

H I J K L M
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Chapter 15 Troubleshooting 

This section discusses the following topics: 

 Error Monitoring (section 15.1) 

 Registering the Failure Monitoring Account (15.2) 

 Error Monitoring (section 15.3) 

 Checking Status (section 15.4) 

 Troubleshooting (section 15.5) 

 Calling the Hitachi Data Systems Support Center (section 15.6) 
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15.1 Error Monitoring 

15.1.1 Setting Error Monitoring Options 

During error monitoring, when a failure is detected on the monitored array unit, E-Mail 
Report or one specified application can be started. 

In Error Alert Mode, click the E-Mail Error Report Enabled check box and the Execute 
Application check box to enable them. 

1. On the Tool menu, select Error Monitoring  Options. Alternatively, click : 
Error Monitoring Options in the tool bar (see Figure 15.1). 

 

Figure 15.1 Setting Error Monitoring Options 

15.1.1.1 Interval Time 

1. Specify the interval time for error monitoring. 

Specify Interval Time in the range of 1 minute to 720 minutes (12 hours). The 
interval means the time from an end of all target array unit monitoring until the 
start of the next monitoring. 

2. Click OK. 

The setting is validated without rebooting Storage Navigator. 
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15.1.2 E-Mail Report 

When a failure is detected in the array unit, a text format log file is output to the same 
directory as the Storage Navigator execution file. Errors are also reported by e-mail 
when an error is detected, it is reported by e-mail. The source of the error is contained 
in the subject line. Table 15.1 shows a list of subjects. For the text of the error 
messages, please refer to Hitachi TagmaStore AMS/WMS Error Codes (MK-96RD788). 

Table 15.1 List of E-Mail Subjects 

No. Subject Meaning 

1 Disk A drive blockade occurred (for 9200). 

2 FC Disk An FC drive blockade occurred (for 9500V). 

3 SATA Disk An SATA drive blockade occurred. 

4 DC Power A DC power supply failure occurred. 

5 Battery A battery voltage error occurred. 

6 Fan A fan failure occurred. 

7 Controller A controller blockade occurred. 
(This occurs only in the dual controller configuration.) 

8 AC Power An AC power supply error occurred. 

9 Cache Memory A cache failure occurred. 

10 Cache Backup Circuit A backup circuit failure occurred. 

11 ENC An enclosure error occurred. 

12 SENC A SENC error occurred. 

13 Loop A loop error occurred. 

14 Path A path blockade occurred. 

15 Warning The array unit entered the warning state. 

16 Array connection A failure occurred in the connection with the array unit. 
A power OFF or a failure occurred in the array unit. 

17 Host Connector A host connector error occurred (for AMS500/200). 

18 NNC An NNC blockade occurred (for AMS500/200). 

 

1. Specify setting items in the E-Mail Report. 

– E-Mail Error Report Enabled: Specifies whether or not to execute E-Mail Report 
when an error is detected by error monitoring. When this item is checked off, E-
Mail Report will be executed. ON/OFF is displayed on the right side, depending 
on whether a check mark exists or not. 

– Domain Name: Specifies a domain name. Specify it in 39 or less alphanumeric 
characters or in a code. 

– Mail Server Address: Specifies the IP address or host name of the mail server. 
Specify the host name in 99 or less alphanumeric characters. 
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– From Address: Specifies the mail address of the E-Mail sender. Specify it in 99 or 
less alphanumeric characters or in a code. 

– Send To Address: Specifies the mail address of the E-Mail receiver. Specify it in 
99 or less alphanumeric characters or in a code. 

Up to 20 addresses can be set as receivers. 

Add: Specify Send To Address in the text box above the Add button, and select 
Add. Send To Address added to the Send To Address list is displayed. 

Replace: Select the Send To Address to be replaced in the Send To Address list. 
Specify Send To Address in the text box above the Add button, and click 
Replace. The replaced Send To Address is displayed in the Send To Address list. 

Delete: Click Send To Address to be deleted in the Send To Address list, and 
click Delete. The deleted Send To Address disappears from the Send To 
Address list. 

2. To verify the setting, click Test. 

When the mail has been normally transmitted, a confirmation message displays. 
Click OK. 

The following mail is transmitted to the set, Send To Address. Check the receipt of 
mail by Send To Address. If the mail has not been received, check the setting. 

Subject: Storage Navigator Modular/Obstruction (test) 

message: Day, Mon. dd hh:mm:ss yyyy/DF Name /Test message 

Day: Day of the week hh:mm:ss: Hours, minutes, and seconds 

Mon: Month   yyyy: Year 

dd: Date 

3. Click Close. 

The setting is validated without rebooting the Storage Navigator. 
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15.1.3 Setting Additional Information on E-mail 

When registering or changing the properties of an array unit, you can add unique 
information on the e-mail header or on the unit trace information header. 

 In the Properties window of the array unit, in the Mail Additional Information text 
box, enter the information in less than or equal to 64-byte characters (see Figure 
15.2). 

 

Figure 15.2 Setting Additional Information on E-Mail 

The information set on E-Mail is added to the E-Mail attribute. The format is as 
follows: 

Day, Mon. dd hh:mm:ss yyyy/DF Name/Additional Information/message text 

To delete the information, select text and press the Delete key. 
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15.1.4 Executing Application 

Execute Application is set so that another application may be started if an array unit 
error is detected when error monitoring is executed. 

The application to be started activates the window; it displays the current size and 
position. 

1. Set the necessary items to start an application. 

– Execute Application: Specifies whether or not to activate the application when 
a failure is detected by the error monitoring. The application is activated when 
the check box is selected. ON/OFF is displayed on the right side, depending on 
whether a check mark exists or not. 

– Application Execute Mode: Specifies an occasion to activate the application: 

– On the first failure: The specified application is activated when the first 
failure is detected after the error monitoring has been activated. When 
failures are detected continuously, the application is not activated. To 
activate the application again when a failure is detected after the 
application has been activated, terminate the error monitoring once and 
then restart it. 

– On every failure: The specified application is activated when a failure is 
detected after the error monitoring has been activated. When the same 
failure is detected while the error monitoring is executed, the application is 
not activated at the second and subsequent detections of it. 

Note: When you select On every failures, the specified application is started 
upon detection of each error. Consequently, multiple specified applications may 
be started and the system may hang-up. Select On the first failure, and after 
occurrence of an error, stop error monitoring and restart it after a recovery from 
the error. 

If an error is caused by starting the specified application during error monitoring, 
a message is displayed and error monitoring is suspended. When the message is 
closed, this monitoring will be continued. 

– Application Name: Specifies a path and a file name of the application to be 
activated. When the file name is long, enclose it with the quotation marks ( “ ). 
When specifying a data file name of the application, if the data file is not in the 
same directory as Storage Navigator, specify the full path. 

– For Windows®: 

Example 3: “c:\abc\application.exe(option)” ”c:\abc\application.dat” 

Path and file name of the application Data file name of the application  
 

– For Solaris™, IRIX®, HP-UX, or Red Hat® Linux®: 

Example 1:/home/use/stonavm/go 

Data file name of the application  

2. To check the setting, click Test. Verify that the specified application is started. 
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15.2 Registering the Failure Monitoring Account 

To register a failure monitoring account: 

1. On the Tool menu, select Error Monitoring  Account to open the Monitoring 
Account Information window (see Figure 15.3). 

2. In that window, do the following: 

– Select the Enable radio button on the Monitoring Account box 

– Enter the previously registered User ID and the Password.  

3. The Monitoring Test Result list displays the array units that have validated failure 
monitoring enabled.  

4. Test the validation by selecting the array unit from the list and clicking the Test 
button. The Result column should display OK.  

5. Select the OK button, then select OK on the confirmation message. You do not need 
to reboot the Storage Navigator computer.  

6. If a failure is detected in the array unit, a text format log file is output to the 
monitoring account and to the same directory as the Storage Navigator execution 
file. For a list of error messages, please refer to Hitachi TagmaStore AMS/WMS Error 
Codes (MK-96RD788). 

 

Figure 15.3 Monitoring Account Information Window 
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15.3 Error Monitoring 

Error monitoring checks the component status of the array unit. This including drives, 
controller, battery, fan, power supply, and cache. Placing a check in the Error Watch 
box in registered array unit information enables error monitoring at an interval specified 
for the interval time. 

Note: When you perform error monitoring, be sure to close the Array System Viewer 
window before starting the monitoring. If error monitoring is performed with the Array 
System Viewer window open, array units may not be monitored normally. 

 Select : Error Watch on the Main window (see Figure 15.4). 

 

 

Figure 15.4 Starting Error Monitoring 

Monitoring is started for the array unit for which “Error Alert” is specified. 

The Error Watch button on the Main window displays . 

After the start of error monitoring, the monitoring status is displayed in the status bar. 
The icon displays a monitoring result of the array unit.  

After error monitoring is performed for all the target array units, monitoring will be 
started again for these target array units after the lapse of the specified interval time. 
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The error monitoring status is displayed on the left side of the scroll bar in the following 
three states. In addition, the monitoring result of all the array units subject to 
monitoring is displayed with icons. 
 

Monitoring 
Status 

Display Characters Character Color Array Unit Status 

Stop Stop  Error monitoring is not executed. 

Monitoring Monitoring 
 

Error monitoring is executed and the all the target 
array units are normal. 

 Monitoring 

 
Error monitoring is executed and errors are detected 
in some of the target array units. 

Waiting Waiting 
 

Error monitoring is at the interval time and all the 
target array units that were previously monitored are 
normal. 

 Waiting 

 
Error monitoring is at the interval time and errors are 
detected in some of the target array units that were 
previously monitored. 

As an error monitoring result, the status is displayed with the icon color of the array unit 
in the Main window. 

Array Units in a Dual System 

 

 Not monitored 
 Monitored but failure to authenticate a user 

 

 Normal 

 

 An error is detected. 
 A communication error occurs in a controller. 

 

 A power OFF or a failure of the array unit occurred. 
 A communication error occurs in both controllers. 

Array Units in a Single System 

 

 Not monitored 
 Monitored but failure to authenticate a user 

 

 Normal 

 

 An error is detected. 

 

 A power OFF or a failure of the array unit occurred. 
 A communication error occurred. 
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1. To display the detail information of the array unit, stop error monitoring, select an 
array unit to be displayed, and click : Alert Stop. The contents 
of display may be different depending on the relationship between Error Alert result 
and “Time”, because polling is performed. 

When the icon has a Caution symbol displayed, this represents a communication 
disable status with the array unit; detailed information cannot be displayed. 

2. Click : Alert Stop, and Error Alert will be stopped. The icon of 
the array unit continues to display the last error-monitoring result. 

Click the Array Unit icon in the Main window, and then select : Open on the 
toolbar. 

Note: When the icon has a Caution symbol displayed as an Error Alert result, this 
represents a connection disable status to the array unit or an information get disable 
status from the array unit. The causes are as follows: 
 

Cause Contents of Check 

Communication line failure Check the LAN line. 

Connected array unit failure Check the READY status of the array unit. 

Too high I/O load from the host Check the array unit operation status. 

Execution of the logical unit format of the connected 
array unit, wizard setting of system parameter, or 
SNMP environment information setting 

Check the array unit status or restart the array unit. 

3. Check all of the above. After making sure that connection with the array unit 
displayed in Caution symbol has been enabled, start error monitoring. 

If the icon of the array unit goes yellow because of controller blockage, the same 
status as that of the Caution symbol icon may be provided. 

If error monitoring is performed, though the icon of the array unit is displayed with a 
Caution symbol, the icon of the normal array unit may be displayed with a Caution 
symbol. If the cause corresponds to “Too high I/O load from the host”, continue to 
execute monitoring. 

If a drive whose display color is not blue in Unit Status on the Array System Viewer 
window (a drive that is not logical unit-formatted or an undefined spare drive) is 
pulled out, no error report will be made but it has no effect on the operation. Insert 
it once again. 

If an error occurs, contact your Customer Engineer. 
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15.4 Checking Status 

Check the status of array unit components: drives, controllers, batteries, fans, power 
supply and cache. A status check is done on an array unit for which the check box of the 
Error Alert Flag in “Array Unit Define” is selected. 

 From the View menu, select Refresh (see Figure 15.5). 

 

Figure 15.5 Checking the Status of Subsystem Components 

The status of an array unit for which error monitoring is specified is checked. When 
checking begins, the icon of an array unit is displayed with the check result reflected 
into the icon. 

The status check performs functions equivalent to those of error monitoring. When an 
error is detected in an array unit that has been checked, output of a log, sending of an 
E-Mail, and restarting of a specified application are performed in accordance with the 
settings of the monitor options. 
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15.5 Troubleshooting 

The user is responsible for operation and normal maintenance of the computer(s) that 
host Storage Navigator software. Following are guidelines for troubleshooting Storage 
Navigator software operations: 

 Check the cabling and the LAN. Verify that both the computer and LAN cabling are 
firmly attached, and that the LAN is operating properly. 

 Reboot the computer. Close any programs that are not responding. If necessary, 
reboot the computer. 

 If Storage Navigator does not succeed in connecting to the array unit, the following 
message may display: 

An invalid response was received from the subsystem 

This indicates that Storage Navigator may have been connected to the array unit 
while the array unit automatically rebooted. Connect to the array unit again after 
approximately three minutes. 

 Storage Navigator may hang up in the following cases: 

– The communication with the connected array unit fails due to controller 
blockage, array unit failure, or disconnected LAN connection, etc., or the array 
unit receives a Reset/LIP from the host. 

– Other applications are working concurrently and memory utilization or a CPU use 
rate is high. 

 If Storage Navigator hangs up, terminate it forcibly and check the array unit status 
and the connection status of the LAN. Reboot Storage Navigator once again. 

 The Storage Navigator can open multiple Array System Viewer windows for one 
array unit. When multiple Array System Viewer windows are open, a shortage of 
memory may occur, depending on the configuration of the system in which the 
Storage Navigator has been installed; this results in program hang-ups. When opening 
Array System Viewer windows, open only one window to operate an array unit. 
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15.6 Calling the Hitachi Data Systems Support Center 

If you need to call the Hitachi Data Systems Support Center, make sure you can provide 
as much information about the problem as possible. Include the circumstances 
surrounding the error or failure, the Storage Navigator configuration information, and 
the exact content of messages displayed on the Storage Navigator. 

Worldwide Hitachi Data Systems Support Centers are: 

 Hitachi Data Systems North America/Latin America 
San Diego, California, USA 
800-446-0744 

 Hitachi Data Systems Europe 
Contact Hitachi Data Systems Local Support 

 Hitachi Data Systems Asia Pacific 
North Ryde, Australia 
61-2-9325-3300  
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Acronyms and Abbreviations  
Acronym Expansion 

A Ampere 
AL-PA arbitrated loop-physical address 
AMS Adaptable Modular Storage 
API application programming interface 
ASTM American Society for Testing Materials 
ATA Advanced Technology Attachment standard 
ATM  asynchronous transfer mode 

BC business continuity 
BS Basic (power) supply 
BSA bus adapter 
BTU British thermal unit 

CCI  command control interface 
CEC Canadian Electroacoustic Community 
CFW cache fast write 
CHAP challenge handshake authentication protocol 
CIFS common internet file system 
CKD count-key data 
CLI  command line interface 
CSA Canadian Standards Association 
CSV comma separated value 
CTG  consistency group 
CTL  controller 
CU controller unit 
CUDG control unit diagnosis 

dB(A) decibel (A-weighted) 
D-CNT  default (owner) controller 
DAMP Disk Array Management Program 
DDL data definition language 
DHCP dynamic host configuration protocol 
DKC disk controller unit 
DLM data lifecycle management 
DM-LU differential management logical unit 
DRAM dynamic random access memory 
DWDM  dense wavelength division multiplexer 

EMI electromagnetic interference 
EPO emergency power-off 

FC fibre channel 
FC-AL fibre channel-arbitrated loop 
FCC Federal Communications Commission 
FCP fibre-channel protocol 

Gbps gigabit per second 

HA high availability 
HACMP high availability cluster multi-processing 
HBA host bus adapter 
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HDLM Hitachi Dynamic Link Manager 
HORCM Hitachi Open Remote Copy Manager  
H-LUN host logical unit 
H-RAIN heterogeneous redundant array of independent nodes 
HSN hierarchical star network 
HWM high water mark 

IDE integrated drive electronics; see also ATA. 
IIS Internet Information Service 
IOPS  input output operations per second 
IOS internet work operating system 
iSCSI internet small computer system interface 

JRE Java 2 runtime environment 

LCP local control port 
LD logical device 
LDEV logical device  
LDM logical device manager 
LIP loop initialization primitive 
LRU least recently used 
LUN logical unit number 
LUSE  LU size expansion 
LVI logical volume image  
LVM logical volume manager 

MCU  main control unit 

NDMP Network Data Management Protocol 
MDB master directory block 
MIB message information block  
μP microprocessor 
MR magneto-resistive 
MU  mirror unit 
MVS multiple virtual storage 
MVS/ESA multiple virtual storage /enterprise systems architecture 
MVS/XA multiple virtual storage /extended architecture 

NAS network attached storage 
NBU NetBackup (a Symantec product) 
NEC National Electrical Code 
NFS network file system 
NIC network interface card 
NIS network information service 
NNC network node controller 
NSC network storage controller 
NTP  network time protocol 
NVS nonvolatile storage 

OCI Oracle Call Interface 
ODM object data manager 
OFC open fibre control 
ORM online read margin 
OSI open systems interconnection 
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PCI power control interface 
PDL product documentation library 
PFUS pool full status 
POSIX portable operating system interface 
PPRC peer-to-peer remote copy 
PSUE pair suspended-error status 
PSUS pair suspended-split 
PSUS(N) pair suspended – not restored status 
PV physical volume 
P-VOL primary volume 

RAID redundant array of independent disks 
RC reference code 
RCU remote control unit 
RPO  recovery point objective 
RTC real-time clock 
RTO  recovery time objective 

SAN storage-area network  
SATA serial ATA  
SCSI small computer system interface 
SIM  service information message 
SM shared memory module 
SMB server message block 
SMTP simple mail transfer protocol 
SNIA  Storage Networking Industry Association 
SNMP simple network management protocol 
SONET  synchronous optical network 
SSL secure socket layer 
SSWS suspend for swapping S-VOL 
S-VOL secondary volume 

TID target identifier 
TPOF tolerable points of failure 

UDP user diagram protocol 
UL Underwriters’ Laboratories 
USP  Universal Storage Platform 

VCS Veritas Cluster Server™ 
VDE Verband Deutscher Elektrotechniker 
VIB volume information block  
VOLID volume identifier 
V-VOL virtual volume (Snapshot Image) 
VxVM Veritas Volume Manager 

WDM wavelength division multiplexing 
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